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Networks standard commercial license in accordance with U.S. Federal Regulations at 48 C.F.R. Sections 
12.212 (for non-DoD entities) and 48 C.F.R. 227.7202 (for DoD entities).
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Preface

BayRS* Version 15.4.0.0 is a software release that includes bug fixes and new 
features added since BayRS Version 15.3.0.0. This document change notice 
contains amendments to the following BayRS manuals since BayRS Version 
15.1.0.0:

• BayRS Online Library

• Configuring and Managing Routers with Site Manager

• Configuring ATM Services

• Configuring Bridging Services

• Configuring Differentiated Services

• Configuring Ethernet, FDDI, and Token Ring Services

• Configuring Frame Relay Services

• Configuring IP, ARP, RIP, RARP, and OSPF Services

• Configuring IP Multicasting and Multimedia Services

• Configuring RADIUS

• Configuring the Technician Interface Scripts

• Configuring the Technician Interface Software

• Configuring Traffic Filters and Protocol Prioritization

• Configuring VRRP Services

• Configuring X.25 Services

• Quick-Starting Routers

• Upgrading Routers to BayRS Version 15.x
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BayRS Version 15.4.0.0 Document Change Notice
Before You Begin

Before using this notice, you must complete the following procedures. For a new 
router:

• Install the router (see the installation guide that came with your router).

• Connect the router to the network and create a pilot configuration file (see 
Quick-Starting Routers, Configuring Remote Access for AN and Passport 
ARN Routers, or Connecting ASN Routers to a Network).

Make sure that you are running the latest version of Nortel Networks* BayRS and 
Site Manager software. For information about upgrading BayRS and Site 
Manager, see the upgrading guide for your version of BayRS.

Text Conventions

This guide uses the following text conventions:

angle brackets (< >) Indicate that you choose the text to enter based on the 
description inside the brackets. Do not type the 
brackets when entering the command.

Example: If the command syntax is:
ping <ip_address>, you enter:
ping 192.32.10.12

bold text Indicates command names and options and text that 
you need to enter.

Example: Enter show ip {alerts | routes}.

Example: Use the dinfo command. 

braces ({}) Indicate required elements in syntax descriptions 
where there is more than one option. You must choose 
only one of the options. Do not type the braces when 
entering the command.

Example: If the command syntax is:
show ip {alerts | routes}, you must enter either:
show ip alerts or show ip routes, but not both.
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Acronyms

This guide uses the following acronyms:

italic text Indicates new terms, book titles, and variables in 
command syntax descriptions. Where a variable is two 
or more words, the words are connected by an 
underscore.

Example: If the command syntax is:
show at <valid_route>
valid_route is one variable and you substitute one value 
for it.

separator ( > ) Shows menu paths. 

Example: Protocols > IP identifies the IP option on the 
Protocols menu. 

vertical line ( | ) Separates choices for command keywords and 
arguments. Enter only one of the choices. Do not type 
the vertical line when entering the command.

Example: If the command syntax is:
show ip {alerts | routes}, you enter either:
show ip alerts or show ip routes, but not both.

ARN Advanced Remote Node

ARP Address Resolution Protocol

ATM asynchronous transfer mode

DSQMS differentiated services queue management and 
scheduling

FDDI Fiber Distributed Data Interface

HSSI High Speed Serial Interface

IP Internet Protocol

LLC Logical Link Control

MTU maximum transmission unit
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Hard-Copy Technical Manuals

You can print selected technical manuals and release notes free, directly from the 
Internet. Go to the www.nortelnetworks.com/documentation URL. Find the 
product for which you need documentation. Then locate the specific category and 
model or version for your hardware or software product. Use Adobe* Acrobat 
Reader* to open the manuals and release notes, search for the sections you need, 
and print them on most standard printers. Go to Adobe Systems at the 
www.adobe.com URL to download a free copy of the Adobe Acrobat Reader.

You can purchase printed books and documentation sets from Vervante. To order 
printed documentation, go to Vervante at the www.vervante.com/nortel URL.

How to Get Help

If you purchased a service contract for your Nortel Networks product from a 
distributor or authorized reseller, contact the technical support staff for that 
distributor or reseller for assistance.

NLPID network layer protocol identifier

PBBI PIM bootstrap border interface

PBBR PIM bootstrap border router

PIM Protocol Independent Multicast

PMC PCI mezzanine card

PVC permanent virtual circuit

QLLC Qualified Logical Link Control

RADIUS Remote Access Dial-In User Services

SRB source route bridge

TOS type of service

VC virtual circuit

VRRP Virtual Router Redundancy Protocol
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If you purchased a Nortel Networks service program, contact one of the following 
Nortel Networks Technical Solutions Centers:

Additional information about the Nortel Networks Technical Solutions Centers is 
available from the www.nortelnetworks.com/help/contact/global URL.

An Express Routing Code (ERC) is available for many Nortel Networks products 
and services. When you use an ERC, your call is routed to a technical support 
person who specializes in supporting that product or service. To locate an ERC for 
your product or service, go to the http://www.nortelnetworks.com/help/contact/
erc/index.html URL.

Technical Solutions Center Telephone

Europe, Middle East, and Africa (33) (4) 92-966-968

North America (800) 4NORTEL or (800) 466-7835

Asia Pacific (61) (2) 9927-8800

China (800) 810-5000
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Chapter 1
BayRS Online Library

Version 15.4.0.0

The following document has been updated since the BayRS Online Library (Part 
No. 314472-A) documentation CD was last issued. 

• Installing BRI Net Modules in ASN Platforms (Part No. 115371-A): This 
document has been revised (Part No. 115371-B) to replace references to Bay 
Networks with Nortel Networks.

You can access the latest version of this document on the Nortel Networks 
Technical Documentation web page. See the following section, “Accessing Nortel 
Networks Technical Documentation on the Web” for instructions.

Accessing Technical Documentation on the Nortel Networks Web Site

Complete the following steps to access the latest version of documentation on the 
web that may not be reflected on the BayRS Online Library documentation CD.

1. Go to http://www.nortelnetworks.com.

2. Select Technical Documentation, under Products, Services and Solutions. 

3. Specify your region and language preferences, as appropriate. You can 
bypass this step if you previously saved your region and language 
preferences. 
314470-15.4 Rev 00 1-1



BayRS Version 15.4.0.0 Document Change Notice
4. At Select a Product, select the appropriate BayRS product category. The 
BayRS product categories include:

• Access Stack Node Router (Hardware Documents)

• Backbone Concentrator Node (BCN) Router (Hardware Documents)

• Backbone Concentrator Node (BLN) Router (Hardware Documents)

• Backbone Node (BN) Router (Hardware Documents)

• Bay Networks Routers (Hardware Documents)

• BLN-BCN ATM Link Modules (Hardware Documents)

• BLN-BCN LAN Link Modules (Hardware Documents)

• BLN-BCN WAN Link Modules (Hardware Documents)

• Passport 2430 Router (Hardware Documents)

• Passport 5430 Router (Hardware Documents)

• Router Software <version> (Software Documents)

5. Click the View Documents button.

6. Click the PDF link for the document that you want to view or download. 
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Chapter 2
Configuring and Managing
Routers with Site Manager

Version 15.3.0.0

The following section is an amendment to Chapter 7, “Monitoring Trap and Event 
Messages” in Configuring and Managing Routers with Site Manager.

Changing the Trap Port for 
Multiple Network Management Applications

If you are running more than one network management application on your Site 
Manager workstation, you must configure Site Manager to receive trap messages 
from the SNMP agent on a port other than the default port, 162. This is necessary 
for the following reasons:

• The agent can only send trap messages to one network management 
application at a time.

• Only one application can map to a UDP port at a time.

By default, the network management application on your workstation is 
assigned to User Datagram Protocol (UDP) port 162. This port is dedicated to 
receiving SNMP trap messages from the SNMP agent. 

Site Manager is the preferred network management application for receiving 
trap messages. To avoid any problems when running another network 
management application, Nortel Networks recommends that you configure 
Site Manager to map to an alternative UDP port. This allows you to send trap 
messages to Site Manager directly.
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To reconfigure the trap port:

1. In the Configuration Manager window, choose Protocols > IP > SNMP > 
Communities.

The SNMP Community List window opens.

2. Choose Community > Managers.

The SNMP Manager List window opens.

3. Choose Manager > Edit Manager.

The Trap Port and Trap Types window opens.

4. Type a new port number for the Trap Port parameter, then click on OK.

You can enter any port number on your Site Manager workstation, as long as 
another application is not using that port.

You return to the Configuration Manager window.

5. Choose File > Save to save this configuration file.

See Chapter 3 in Configuring and Managing Routers Using Site Manager for 
instructions on saving configuration files.

6. Choose File > Exit.

You return to the main Site Manager window.

7. Restart Site Manager according to the instructions in Chapter 1 of 
Configuring and Managing Routers Using Site Manager

To make sure that Site Manager is able to listen to the port that you configured 
in step 4, restart Site Manager using the wfsm -e command or the Trap 
Monitor using the wftraps -e command. For more information, about using 
the wfsm and wftraps commands with the -e option, see Appendix A in 
Configuring and Managing Routers with Site Manager.

Note: You can also change the trap port on a PC by editing the 
snmp-trap 162/udp snmp string in the Services file. From the Start menu, 
choose Programs > Windows Explorer. Open the Services file and edit the 
string snmp-trap 162/udp snmp. For example, to change the trap port from 162 
to 779, enter snmp-trap 779/udp snmp and reboot the PC. Site Manager PC 
is then able to receive the traps from the router on port 779.
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Chapter 3
Configuring ATM Services

Version 15.2.0.0

The following section is new to Configuring ATM Services. You use the 
procedures in this section to configure an ATM T3/E3 PMC module installed in a 
Passport* 5430. For information about installing an ATM T3/E3 PMC module, 
see ATM T3/E3 PMC Module Supplement.

Creating an ATM Circuit for a T3 or E3 Connection on a Passport 5430

To start ATM services on an ATM T3/E3 PMC module in the Passport 5430, you 
do the following: 

1. Configure the physical ATM circuit. 

2. Add protocols and other services to that circuit. 

This section describes how you create a physical ATM circuit for a T3 or E3 
connection on a Passport 5430, then directs you to Configuring ATM Services for 
information about adding protocols and further configuring ATM services. 

Using the BCC

To add ATM to a Passport 5430 with a T3/E3 connector, navigate to the box 
prompt and enter:

atm slot <slot_number> pci-slot <pci_slot> module <module_number> 
connector <connector_number> mode {t3 | e3}

slot_number is the number of the chassis slot containing the ATM T3/E3 PMC 
module.
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pci_slot is the number of the PCI slot containing the ATM T3/E3 PMC module. 
The PCI slot number for the ATM T3/E3 PMC module is always 1.

module_number is always 2 for the ATM interface.

connector_number is the number of a connector on the ATM T3/E3 PMC module.

mode t3 or mode e3 specifies whether the ATM interface is a T3 or E3 interface.

For example, the following command adds an ATM T3 interface to the Passport 
5430 configuration on slot 1, PCI slot 1, module 2, connector 1:

box# atm slot 1 pci-slot 1 module 2 connector 1 mode t3
atm/1/1/2/1#

To configure T3/E3 parameters, use the following procedures.

Specifying the Cable Length

To specify the cable length, navigate to the ATM interface prompt (for example, 
box; atm/1/1/2/1; atm-e3) and enter:

cable-length <length>

length is either short (default) or long. Specify short for a cable less than 225 feet 
long; specify long for a cable length of 225 feet or more.

For example, the following command changes the cable length to long:

atm-e3/1/1/2/1# cable-length long
atm-e3/1/1/2/1#

Specifying the Clear Alarm Threshold

To specify the duration of time (in seconds) that elapses following the clearing of 
a performance failure (before the condition is registered and logged), navigate to 
the ATM interface prompt (for example, box; atm/1/1/2/1; atm-e3) and enter:

clear-alarm-threshold <integer>

integer is a value from 2 through 10 seconds, inclusive. 
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For example, the following command changes the clear alarm threshold from 2 to 
8 seconds:

atm-e3/1/1/2/1# clear-alarm-threshold 8
atm-e3/1/1/2/1#

Specifying the Line Coding Method

To specify the line coding method, navigate to the ATM interface prompt (for 
example, box; atm/1/1/2/1; atm-e3) and enter:

line-coding {hdb3 | b3zs}

The default for the ATM E3 interface is hdb3 and the default value for the ATM 
T3 interface is b3zs.

Specifying the Line Type

To specify the line type for this interface, navigate to the ATM interface prompt 
(for example, box; atm/1/1/2/1; atm-e3) and enter:

line-type <type>

type is autodetect, ds3m23, or ds3cbitparity for the ATM T3 interface and 
e3framed or e3plcp for the ATM E3 interface. 

If the line type is ds3m23, the framing mode should be m23 or t3m23plcp. 

If the line type is ds3cbitparity, the framing mode should be cbit or t3cbitplcp. 

If the line type is either e3framed or e3plcp, the framing mode should be either 
g751or g832.

For instructions on setting the framing-mode parameter, see Configuring ATM 
Services.

Specifying the Loopback Mode

To force the interface into loopback mode so that the far-end or intermediate 
equipment can perform diagnostics on the network between that equipment and 
the T3/E3 interface, navigate to the ATM interface prompt (for example, box; 
atm/1/1/2/1; atm-e3) and enter:

loopback-mode <type>
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type is payloadloop or lineloop. 

If you select payloadloop, the received signal at this interface is looped through 
the device. Typically, the received signal is looped back for retransmission after it 
has passed through the device’s framing function. 

If you select lineloop, the received signal at this interface does not go through the 
framing device (minimum penetration) but is looped back out. The default is 
noloop.

For example, the following command changes the loopback mode to payloadloop:

atm-e3/1/1/2/1# loopback-mode payloadloop
atm-e3/1/1/2/1#

Defining the Interface MTU

The maximum transmission unit (MTU) is the largest possible unit of data that the 
physical medium can transmit. By default, the interface allows an MTU size of 
4608 octets. This value can handle most packet sizes. However, you can set the 
MTU to any value from 3 through 4608 octets.

To modify the interface MTU, navigate to the ATM interface prompt (for 
example,
box; atm/1/1/2/1; atm-e3) and enter:

mtu <integer>

integer is the MTU size in octets.

For example, the following command sets the MTU size to 3000 octets:

atm-e3/1/1/2/1# mtu 3000
atm-e3/1/1/2/1#

Defining the Primary Clock Source

To define the clock signal source, navigate to the ATM interface prompt (for 
example, box; atm/1/1/2/1; atm-e3) and enter:

primary-clock-source <value>

value is internal or loop. If you select internal, the router will generate the clock 
signal source. If you select the default, loop, the clock signal source will be 
external to the router.
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For example, the following command sets the clock source to internal:

atm-e3/1/1/2/1# primary-clock-source internal
atm-e3/1/1/2/1#

Specifying the Setup Alarm Threshold

To specify the duration of time (in seconds) that elapses following the detection of 
a performance failure, before the condition is registered and logged, navigate to 
the ATM interface prompt (for example, box; atm/1/1/2/1; atm-e3) and enter:

setup-alarm-threshold <integer>

integer is a value from 2 through 10 seconds, inclusive. 

For example, the following command changes the setup alarm threshold from 2 to 
8 seconds:

atm-e3/1/1/2/1# setup-alarm-threshold 8
atm-e3/1/1/2/1#

Disabling and Reenabling the ATM interface

By default, the ATM interface is enabled when you create the circuit. However, 
you can disable or reenable the interface at any time. When the interface is 
enabled, traffic can flow over the interface. When the interface is disabled, traffic 
cannot flow over the interface.

To disable or reenable the ATM interface, navigate to the ATM interface prompt 
(for example, box; atm/1/1/2/1; atm-e3) and enter:

state {disabled | enabled}

For example, the following commands disable and reenable the ATM interface:

atm-e3/1/1/2/1# state disabled
atm-e3/1/1/2/1# state enabled
atm-e3/1/1/2/1#
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Using Site Manager

To create an ATM circuit for a T3 or E3 connection on a Passport 5430, complete 
the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM DS3/E3 interface (ATM1) 
in slot 1, PCI slot 1, module 2.

The Add Circuit window opens.

2. Click on OK to accept the default circuit 
name.

The ATM Configuration window opens.

3. Click on Physical Layer Configuration. The Physical Layer Configuration window 
opens.

4. Click on either DS3 or E3. The Port Parameters window opens.

5. To configure port parameters, set the 
following parameters as needed:
• Enable/Disable
• Line Type
• Setup Alarm Threshold (seconds)
• Clear Alarm Threshold (seconds)
• Loopback Configuration
• Primary Clock
Click on Help or see the parameter 
descriptions in “ATM Port Parameters,” 
beginning on page A-4.

6. Click on OK. The Physical Layer Configuration window 
opens.

7. Click on Done. The ATM Configuration window opens.

8. Click on ATM Line Attributes. The ATM Line Driver Attributes window 
opens.

(continued)
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After you create the ATM circuit, go to Chapter 2, “Starting ATM and ATM 
Router Redundancy,” in Configuring ATM Services to finish configuring ATM 
services.

Configuring ATM Services also provides more information about ATM services 
and how to modify an existing ATM configuration.

9. Set the the following parameters as 
needed:
• Enable
• Interface MTU
• Data Path Enable
• Data Path Notify Timeout
• Framing Mode
• Cell Scrambling
• Per-VC Clipping
• DS3 Line Build Out
Note: The Cell Scrambling parameter 
value must be the same as for the other 
ATM devices on your network. See your 
system administrator or your service 
provider for the appropriate value.

Click on Help or see the parameter 
descriptions in “ATM Line Parameters” on 
page A-7.

10. Click on OK. The ATM Configuration window opens.

11. Click on ATM. The Edit ATM Connector window opens.

12. Go to “Defining an ATM Service Record” in 
Configuring ATM Services.

Site Manager Procedure (continued)

You do this System responds
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Version 15.3.0.0

The following sections contain amendments to Chapter 3, “Customizing an ATM 
Interface” in Configuring ATM Services.

Defining the SVC Inactivity Timeout

When you enable the SVC inactivity timeout function (the default), the router 
automatically terminates any SVCs that have not received or transmitted any cells. 
If you disable the SVC inactivity timeout function, all SVCs on the line remain 
open until you close them by another method.

When enabled, the SVC inactivity timeout function also requires a timer value. 
This timer value specifies how long you want the ATM router to wait before 
disabling inactive SVCs. By default, if the router does not receive or transmit any 
cells for 1200 seconds, the inactive SVCs are disabled. However, you can set this 
timer to any value from 60 to 3600 seconds.

Using the BCC

To disable the SVC inactivity timeout function, navigate to the ATM prompt (for 
example, box; atm/11/1) and enter:

vc-inactivity-control disabled

For example, the following command disables the SVC inactivity timeout 
function on the ATM interface:

atm/11/1# vc-inactivity-control disabled
atm/11/1#

To reenable the SVC inactivity timeout function, navigate to the ATM prompt and 
enter:

vc-inactivity-control enabled

Note: The vc-inactivity-control parameter is not available for use with the 
ATM T3/E3 PMC module. Instead, the vc-inact-control parameter appears for 
this module. The vc-inact-control parameter cannot be modified.
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To change the SVC inactivity timeout value, navigate to the ATM prompt and 
enter:

vc-inactivity-timeout <integer>

integer is the amount of time (in seconds) that the router waits before it disables 
inactive SVCs.

For example, the following command sequence reenables the SVC inactivity 
timeout function on the ATM interface and sets the SVC inactivity timeout value 
to 2400 seconds:

atm/11/1# vc-inactivity-control enabled
atm/11/1# vc-inactivity-timeout 2400
atm/11/1#

Note: The vc-inactivity-timeout parameter is not available for use with the 
ATM T3/E3 PMC module. Instead, the vc-inact-timeout parameter appears 
for this module. The vc-inact-timeout parameter cannot be modified.
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Defining the Clocking Signal Source

You can specify either an internal or external clocking source for time signals. 
Internal clocking uses the router clock; external clocking uses the line clock.

Using the BCC

To change the source of the ATM clocking signal, navigate to the ATM prompt 
(for example, box; atm/11/1) and enter:

clock-signal-source <source>

source is either internal (default) or external.

For example, the following command changes the ATM clocking signal source to 
external:

atm/11/1# clock-signal-source external

atm/11/1#

Note: The clock-signal-source parameter is not available for use with the 
ATM T3/E3 PMC module. Instead, the clk-signal-source parameter appears 
for this module. The clk-signal-source parameter cannot be modified.
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Chapter 4
Configuring Bridging Services

Version 15.2.0.0

The following section corrects erroneous text in Configuring Bridging Services.

Interfaces Supported

The section “Interfaces Supported” under “Implementation Notes” in Configuring 
Bridging Services incorrectly states that the translation bridge can operate on all 
SR interfaces supported by Nortel Networks routers except IP. The translation 
bridge can operate on all SR interfaces supported by Nortel Networks routers 
except for interfaces configured for SRB with IP encapsulation.
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Chapter 5
Configuring Differentiated Services

Version 15.1.0.0

The following section describes a change to Configuring Differentiated Services.

Modifying RED Parameters

The following change is required to Table 6-1 in the “Modifying RED 
Parameters” section of the Configuring Differentiated Services book. 

The proper range of values for the id parameter is from 1 through 65535. The 
proper range is shown in the following table, which lists RED parameters that can 
be configured under dsqms-red, their values, and functions.

Parameter Values Function

id integer 1 through 
65535

Identifies the RED function. You cannot 
change this parameter.

min-threshold integer 0 through 
100 (default 20)

Indicates the queue size below which no 
packets are dropped by RED

max-threshold integer 1 through 
100 (default 80)

Indicates the queue size above which all pack-
ets are dropped by RED

first-order-const integer 0 through 
100 (default 1)

Specifies the first order constant used when 
calculating drop probability based on the aver-
age queue fraction, the queue size, and the 
min-threshold value

second-order-const integer 0 through 
1000 (default 10)

Specifies the second order constant used 
when calculating drop probability based on 
the average queue fraction, the queue size, 
and the min-threshold value
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Version 15.2.0.0

The following section corrects erroneous text in the description of the Priority 
parameter.

Priority Parameter

The description of the Priority parameter in Appendix A incorrectly states that the 
lower the number, the higher the priority. The description should state that the 
higher the number, the higher the priority. For example, a server with a priority of 
2 will be the active server before a server with a priority of 1.

Version 15.3.0.0

The following section is an amendment to Chapter 2, “Starting Differentiated 
Services” in Configuring Differentiated Services.

Implementation Notes

The following guidelines can help you successfully configure DSQMS on your 
router:

• You can configure DSQMS on these interfaces only: HSSI, MCT1, MCE1, 
T1/FT1, E1/FE1, and synchronous.

• If you enable flow fairness on a queue, you cannot configure that queue as a 
best-effort queue. For information about enabling flow fairness on a queue or 
designating the queue as best effort, see “Modifying a DSQMS Queue” in 
Configuring Differentiated Services.

• If you configure both weighted and priority queues on an interface, you may 
experience latency problems with the highest priority queues. To avoid such 
problems:

-- Set the DSQMS interface parameter dequeue-at-line-rate to enabled 
(the default value is disabled). See “Configuring DSQMS to Dequeue 
Packets at Line Rate” in Configuring Differentiated Services for 
instructions.

-- Ensure that the amount of high-priority traffic is not excessive in the 
highest priority queues.
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• If you implement RED for queue management instead of tail-drop (that is, 
you set the queue parameter drop-type to red and you associate the queue 
classifier with a RED function), the probability of dropping packets may 
adversely affect the latency requirements of some applications. Adjust the 
following parameters to achieve the required latency levels for the queue:

-- RED parameters min-threshold and max-threshold (see “Modifying 
RED Parameters” on page 3-1 for instructions).

-- Queue parameters average-queue-gain and idle-queue-loss-rate (see 
“Modifying a DSQMS Queue” in Configuring Differentiated Services for 
instructions).

Version 15.4.0.0

The following section is an amendment to Chapter 2, “Starting Differentiated 
Services” in Configuring Differentiated Services.

Implementation Notes

The following guidelines can help you successfully configure DSQMS on your 
router:

• You can configure DSQMS on these interfaces only: Ethernet, HSSI, MCT1, 
MCE1, T1/FT1, E1/FE1, and synchronous.

• If the Ethernet interface is connected to an external access device such as DSL 
or Cable modem, then Nortel Networks recommends considering policing on 
the ingress interface of the router by configuring traffic filters and also 
enabling dequeue-at-line-rate in DSQMS on the egress ethernet interface for 
traffic management.

• If you enable flow fairness on a queue, you cannot configure that queue as a 
best-effort queue. For information about enabling flow fairness on a queue or 
designating the queue as best effort, see “Modifying a DSQMS Queue” in 
Configuring Differentiated Services.

• If you configure both weighted and priority queues on an interface, you may 
experience latency problems with the highest priority queues. To avoid such 
problems:
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-- Set the DSQMS interface parameter dequeue-at-line-rate to enabled 
(the default value is disabled). See “Configuring DSQMS to Dequeue 
Packets at Line Rate” in Configuring Differentiated Services for 
instructions.

-- Ensure that the amount of high-priority traffic is not excessive in the 
highest priority queues.

• If you implement RED for queue management instead of tail-drop (that is, 
you set the queue parameter drop-type to red and you associate the queue 
classifier with a RED function), the probability of dropping packets may 
adversely affect the latency requirements of some applications. Adjust the 
following parameters to achieve the required latency levels for the queue:

-- RED parameters min-threshold and max-threshold (see “Modifying 
RED Parameters” on page 3-1 for instructions).

-- Queue parameters average-queue-gain and idle-queue-loss-rate (see 
“Modifying a DSQMS Queue” in Configuring Differentiated Services for 
instructions).
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Chapter 6
Configuring Ethernet, FDDI, and Token Ring

Services

Version 15.4.0.0

The following section is new to Chapter 2 of Configuring Ethernet, FDDI, and 
Token Ring Services.

The sections “Router Processing of Tagged Frames,” “Implementation 
Considerations,” “Adding a Tagged Circuit to an Unconfigured 10BASE-T or 
100BASE-T Interface,” and “Adding a Tagged Circuit to an Existing 10BASE-T 
or 100BASE-T Interface” contain amendments to Chapter 5 of Configuring 
Ethernet, FDDI, and Token Ring Services.

Specifying the DSQMS Line Speed

You specify the DSQMS line speed using the dsqms-line-speed parameter. You 
access this parameter by navigating to the ethernet prompt (for example, box; 
ethernet 2/1) and entering the following command

dsqms-line-speed <value>

value specifies the line speed (in bits per second) for the DSQMS client. The 
default is 1250000 (1.25Mbps). 

In network configurations where the Ethernet interface is connected to an external 
access device such as DSL or a Cable modem, the dsqms-line-speed parameter 
can be used in conjunction with dequeue-at-line rate parameter enabled on the 
egress interface and traffic policing on the ingress interface for traffic 
management.
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For example, to change the line speed to 10Mbps:

ethernet/2/1# dsqms-line-speed 10000000
ethernet/2/1# 

Router Processing of Tagged Frames

802.1Q tagging is supported on 10BASE-T and 100BASE-T interfaces that 
connect the Nortel Networks router to an 802.1Q-compliant switch or routing 
switch. With 802.1Q tagging enabled, the physical connection between the router 
and the adjacent device supports multiple virtual connections.

The number of connections is equal to the number of virtual connections plus a 
default physical connection that provides transit services for other non-VLAN 
traffic that may be received from or forwarded to the adjacent device.

Upon receipt of a frame across a virtual connection, a circuit manager strips the 
four bytes of 802.1Q header information and directs a now standard Ethernet 
frame to a connection-specific routing process. The routing process consults its 
forwarding table and, in turn, directs the frame to a circuit manager handling the 
next-hop connection. If that connection is a non-tagged, non-virtual connection, 
processing is completed as for any other standard Ethernet frame.

However, if the next-hop connection is a tagged, virtual connection, the circuit 
manager inserts the four bytes of 802.1Q header information that identify that 
VLAN into the standard Ethernet header. After performing the 802.1Q 
encapsulation, the circuit manager forwards the frame across the virtual 
connection toward the destination VLAN.

Implementation Considerations

Before you configure 802.1Q tagging on a router, note the following 
considerations:

• 802.1Q tagging is supported on 10BASE-T and 100BASE-T interfaces; it is 
not supported on other LAN interfaces.

• 802.1Q tagging cannot be used to extend a VLAN across multiple devices.

• The VLAN type (port-based, protocol-based, address-based, and so on) is 
ignored by the router.
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• The following table shows the modules that support 802.1Q tagging:

Table 6-1. Supported Modules for 802.1Q Tagging

Platform Ethernet Interface Type

Passport 2430 10/100 Base Unit

Passport 2430 Second Ethernet Module

ARN Ethernet Base Unit

ARN ARN -48VDC Ethernet Base Unit

ARN 10/100-TX UTP Base Unit

ARN Ethernet Expansion Module

ARN Ethernet and Tri-Serial Expansion Module

ARN Ethernet and 7-Serial Expansion Module

Passport 5430 Dual 10/100 Ethernet Base Unit

ASN Dual Ethernet Net Module

BLN/BCN Quad Port Ethernet FRE2-060

BLN/BCN Quad Port Ethernet – High Speed Filters FRE2-060

BLN/BCN Dual Ethernet/Dual Sync – No Filters FRE2-060 

BLN/BCN Dual Ethernet/Dual Sync – Max. Filters FRE2-060

BLN/BCN Ethernet Sync/Async No Filters (ESAF) FRE2-060E

BLN/BCN Ethernet Sync/Async With Filters (ESAFNF) FRE2-060E

BLN/BCN Quad Port 10/100Base-TX with FRE4-PPC
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Adding a Tagged Circuit to an Unconfigured 10BASE-T or 100BASE-T 
Interface

The following procedure describes how to add an 802.1Q tagged circuit to a 
previously unconfigured 10BASE-T or 100BASE-T interface. The procedure 
assumes that you are configuring the 802.1Q tagged circuit for IP routing. To 
enable other routing protocols on an 802.1Q tagged circuit, see the appropriate 
guide for that protocol. 

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on a 100BASE-T connector.

The Add Circuit window opens.

2. Click on OK. The Select Protocols window opens.

3. Choose VLAN, then click on OK. The Edit VLAN Interface Parameters 
window opens.

4. Click on Add. The TAG1Q Parameters window opens.

5. Set the following parameters:
• VLAN Name
• Global VLAN Id
Click on Help to see the parameter 
descriptions.

6. Click on OK. The Edit VLAN Interface Parameters 
window opens. Note that 802.1Q tagged 
circuits are displayed with a Vn extension.

7. Select the 802.1Q tagged circuit that you 
are adding. Set the Protocol Type (hex) 
parameter. Retain the default value for 
connection to Nortel Networks 
802.1Q-enabled devices.

8. Click on Apply and Done. You return to the Configuration Manager 
window.

To add IP routing to the 802.1Q tagged circuit:

9. Choose Circuits.

10. Choose Edit Circuits. The Circuit List window opens.

11. Select the 802.1Q tagged circuit. 
Note that 802.1Q tagged circuits are 
displayed with a Vn extension.
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Adding a Tagged Circuit to an Existing 10BASE-T or 100BASE-T 
Interface

To add an 802.1Q tagged circuit to an existing 10BASE-T or 100BASE-T 
interface, complete the following tasks: 

12. Click on Edit. The Circuit Definition window opens.

13. Choose Protocols.

14. Choose Add/Delete. The Select Protocols window opens.

15. Select IP and click on OK. The IP Configuration window opens.

16. Enter an IP address and subnet mask and 
click on OK.

The Circuit Definition window opens.

17. Choose File.

18. Choose Exit. The Circuit List window opens.

19. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on a 10BASE-T or 100BASE-T 
connector.

The Edit Connector window opens.

2. Click on Edit Circuit. The Circuit Definition window opens.

3. Choose Protocols. The Protocols menu opens.

4. Choose Add/Delete. The Select Protocols window opens.

5. Choose VLAN, then click on OK. The Edit VLAN Interface Parameters 
window opens.

6. Click on Add. The TAG1Q Parameters window opens.

7. Set the following parameters:
• VLAN Name
• Global VLAN Id
Click on Help to see the parameter 
descriptions.

Site Manager Procedure (continued)

You do this System responds
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8. Click on OK. The Edit VLAN Interface Parameters 
window opens. Note that 802.1Q tagged 
circuits are displayed with a Vn extension.

9. Select the 802.1Q tagged circuit that you 
are adding. Set the Protocol Type (hex) 
parameter. Retain the default value for 
connection to Nortel Networks 
802.1Q-enabled devices.

10. Click on Apply and Done. You return to the Configuration Manager 
window.

To add IP routing to the 802.1Q tagged circuit:

11. Choose Circuits.

12. Choose Edit Circuits. The Circuit List window opens.

13. Select the 802.1Q tagged circuit. 
Note that 802.1Q tagged circuits are 
displayed with a Vn extension.

14. Click on Edit. The Circuit Definition window opens.

15. Choose Protocols.

16. Choose Add/Delete. The Select Protocols window opens.

17. Select IP and click on OK. The IP Configuration window opens.

18. Enter an IP address and subnet mask and 
click on OK.

The Circuit Definition window opens.

19. Choose File.

20. Choose Exit. The Circuit List window opens.

21. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Chapter 7
Configuring Frame Relay Services

Version 15.1.0.0

The following changes are required to the Configuring Frame Relay Services 
book.

A new frame relay parameter, Bw Threshold, has been added to the PVC List for 
Services window in Site Manager. The Bw Threshold parameter works in 
conjunction with the Committed Burst, Excess Burst, and Throughput parameters 
to shape traffic. 

The following sections update the Site Manager procedure within the “Using 
Traffic Shaping” section in Chapter 4 and adds the parameter description to 
Appendix A: “Site Manager Parameters.”

Using Traffic Shaping – Site Manager

To enable traffic shaping, complete the following tasks using Site Manager:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on a port configured for frame relay.

The Edit Connector window opens.

2. Click on Edit Circuit. The Frame Relay Circuit Definition 
window opens.

3. Click on Services. The Frame Relay Service List window 
opens.

(continued)
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Version 15.2.0.0

The following section describes a limitation that was omitted from Configuring 
Frame Relay Services.

Deleting PVCs from Service Records

The section “Deleting PVCs from Service Records” in Configuring Frame Relay 
Services should include the statement that Site Manager does not allow users to 
delete or move the last PVC in the only non-default service record. If you want to 
delete or move the last PVC, you must remove the entire service record.

4. Select the appropriate service record and 
click on PVCs.

The FR PVC List for Service window 
opens.

5. Click on a PVC that you want to configure 
for traffic shaping. 

6. Set the following parameters:
• Committed Burst
• Excess Burst
• Throughput
• Bw Threshold
Click on Help or see the parameter 
description in “Frame Relay PVC 
Parameter” on page A-13.

7. Click on Done. You return to the Frame Relay Service 
List window.

8. Click on Done. You return to the Frame Relay Circuit 
Definition window.

9. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Chapter 8
Configuring IP, ARP, RIP, RARP, and OSPF

Services

Version 15.3.0.0

The following section is new to Chapter 1, “IP Concepts, Terminology, and 
Features” in Configuring IP, ARP, RIP, RARP, and OSPF Services.

RFC826 Support

BayRS now supports RFC826: An Ethernet Address Resolution Protocol. 
According to RFC826, when a router interface receives an ARP request or reply, it 
checks the source IP address to make sure that it is valid and the router’s 
translation table for the destination IP and MAC address pair. If the saved MAC 
address in the table is different from the reported MAC address, the router 
replaces the old MAC address with the new one. The interface then checks for the 
message type (request or reply). If the router cannot find the MAC address in the 
translation table, it discards the message. 
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Version 15.4.0.0

The following sections are amendments to Configuring IP, ARP, RIP, RARP, and 
OSPF Services.

Defining BGP Peers for BGP, OSPF, and RIP Announce Policies

When defining a BGP peer for an announce policy, the peer must be identified by 
its BGP router ID. To verify the router ID of the BGP peer, on the peer router, 
check the configured value for the Site Manager BGP Global parameter, BGP 
Identifier, or the BCC BGP parameter, router-id. For information about supplying 
a router ID for a BGP router, see Configuring IP Exterior Gateway Protocols 
(BGP and EGP).

Importing RIP updates

You can now select whether the router imports RIP-1 updates only, RIP-2 updates 
only, or both RIP-1 and RIP-2 updates from a neighbor router. The following 
procedures describe how to configure this feature using the BCC and Site 
Manager.

Using the BCC

To have RIP-1 accept both RIP-1 broadcast and RIP-2 multicast packets (and have 
RIP-2 always use multicast for transmitting updates), go to the RIP interface 
prompt (for example, box; eth 2/2; ip/220.1.1.2/255.255.0.0; rip) and enter:

rip1-comp disable

For example, to disable rip1-comp, enter:

rip/220.1.1.2# rip1-comp disable
rip/220.1.1.2# 

To have RIP-1 accept RIP-1 broadcast and RIP-2 broadcast packets only (RIP-1 
will not accept RIP-2 multicast packets) and have RIP-2 broadcast the packets, 
making it compatible with RIP-1, go to the RIP interface prompt (for example, 
box; eth 2/2; ip/220.1.1.2/255.255.0.0; rip) and enter:

rip1-comp enable
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For example, to enable rip1-comp, enter:

rip/220.1.1.2# rip1-comp enable
rip/220.1.1.2# 

Using Site Manager

To have RIP-1 accept both RIP-1 broadcast and RIP-2 multicast packets (and have 
RIP-2 always use multicast for transmitting updates), or to have RIP-1 accept 
RIP-1 and RIP-2 broadcast packets only, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose RIP Interfaces. The IP RIP Interface Configuration 
window opens. 

4. Click on the RIP interface that you want to 
edit.

The parameter values for that interface 
appear in the IP RIP Interface 
Configuration window. 

5. Set the Rip Compatible parameter. Click 
on Help or see the parameter description 
on page A-21.

6. Click on Apply, and then click on Done. You return to the Configuration Manager 
window.
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MIB Object IDs

Please note the changes to the following MIB object IDs (OIDs): 

Note: To get to the following parameters, use the path 
Configuration Manager > Protocols > IP > Interfaces or Configuration 
Manager > Protocols > IP > Global

Site Manager 
Parameter Name Old OID New OID

Subnet Mask 1.3.6.1.4.1.18.3.5.3.2.1.4.1.6 1.3.6.1.4.1.18.3.5.3.2.1.24.1.6

UnNumbered Assoc 
Addr

1.3.6.1.4.1.18.3.5.3.2.1.4.1.110 1.3.6.1.4.1.18.3.5.3.2.1.24.1.47

Mask 1.3.6.1.4.1.18.3.5.3.2.1.4.1.6 1.3.6.1.4.1.18.3.5.3.2.1.24.1.6

Broadcast Address 1.3.6.1.4.1.18.3.5.3.2.1.4.1.9 1.3.6.1.4.1.18.3.5.3.2.1.24.1.8

Cost 1.3.6.1.4.1.18.3.5.3.2.1.4.1.8 1.3.6.1.4.1.18.3.5.3.2.1.24.1.7

Host Cache 1.3.6.1.4.1.18.3.5.3.2.1.24.1.18 1.3.6.1.4.1.18.3.5.3.2.1.24.1.17

TR End Station 1.3.6.1.4.1.18.3.5.3.2.1.4.1.64 1.3.6.1.4.1.18.3.5.3.2.1.24.1.19

TR End Station
ARP Type

1.3.6.1.4.1.18.3.5.3.2.1.4.1.127 1.3.6.1.4.1.18.3.5.3.2.1.24.1.56

Redirect 1.3.6.1.4.1.18.3.5.3.2.1.4.1.70 1.3.6.1.4.1.18.3.5.3.2.1.24.1.25

Ethernet Arp Encaps 1.3.6.1.4.1.18.3.5.3.2.1.4.1.71 1.3.6.1.4.1.18.3.5.3.2.1.24.1.26

SMDS Group 
Address

1.3.6.1.4.1.18.3.5.3.2.1.4.1.65 1.3.6.1.4.1.18.3.5.3.2.1.24.1.20

SMDS Arp Request 
Address

1.3.6.1.4.1.18.3.5.3.2.1.4.1.66 1.3.6.1.4.1.18.3.5.3.2.1.24.1.21

WAN Broadcast 
(was FRB 
Broadcast)

1.3.6.1.4.1.18.3.5.3.2.1.4.1.67 1.3.6.1.4.1.18.3.5.3.2.1.24.1.22

WAN Multicast #1 
(was FRM Cast 1 
DLCI)

1.3.6.1.4.1.18.3.5.3.2.1.4.1.68 1.3.6.1.4.1.18.3.5.3.2.1.24.1.23

WAN Multicast #2 
(was FRM Cast 2 
DLCI)

1.3.6.1.4.1.18.3.5.3.2.1.4.1.69 1.3.6.1.4.1.18.3.5.3.2.1.24.1.24
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Slot Mask 1.3.6.1.4.1.18.3.5.3.2.1.4.1.75 1.3.6.1.4.1.18.3.5.3.2.1.24.1.27

Max Forwarding 
Table Size (was 
Forward Cache Size)

1.3.6.1.4.1.18.3.5.3.2.1.4.1.104 1.3.6.1.4.1.18.3.5.3.2.1.24.1.46

Unnumbered 
Associated Alternate

1.3.6.1.4.1.18.3.5.3.2.1.4.1.111 1.3.6.1.4.1.18.3.5.3.2.1.24.1.47

IP OSPF Maximum 
Path

1.3.6.1.4.1.18.3.5.3.2.3.1.18 1.3.6.1.4.1.18.3.5.3.2.1.1.21

Site Manager 
Parameter Name Old OID New OID
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Chapter 9
Configuring IP Multicasting

and Multimedia Services

Version 15.2.0.0

The following section is new to Configuring IP Multicasting and Multimedia 
Services.

Configuring a PIM Bootstrap Border Router

You can define a router as a PIM bootstrap border router (PBBR) by specifying at 
least one of its interfaces as a PIM bootstrap border interface (PBBI). A bootstrap 
border router prevents a bootstrap message that is received from one side of a 
border router from being passed to the other side of the router. The bootstrap 
border router allows you to create two or more PIM bootstrap domains in one PIM 
domain so that the rendezvous point (RP) information kept in the routers can be 
different.

To specify a PIM bootstrap router as a border router, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose PIM. The PIM menu opens. 

(continued)
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4. Choose Interface. The PIM Interface Parameters window 
opens.

5. Set the Bootstrap Border parameter. 
Click on Help or see the parameter 
description in “IP PIM Parameter” on page 
A-15.

6. Click on OK. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Chapter 10
Configuring RADIUS

Version 15.2.0.0

The following sections are amendments to Configuring RADIUS:

Configuring a RADIUS Client Using Site Manager

With earlier versions of Site Manager, you configured RADIUS only on link 
modules that had synchronous interfaces. With Version 15.2.0.0, you can use Site 
Manager to configure RADIUS on any link module, including Quad Ethernet, 
FDDI, and token ring. Consequently, Site Manager no longer automatically 
configures a demand circuit group when you use it to configure a RADIUS client. 

Topic Page

Configuring a RADIUS Client Using Site Manager 10-1

Modifying Router Access Using the BCC or Site Manager 10-2

Using SecurID for RADIUS Authentication 10-5
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To enable RADIUS on a router slot and configure the RADIUS client:

Modifying Router Access Using the BCC or Site Manager

With RADIUS, you can modify access to the router using the user/manager lock 
and the login accounting feature.

User/Manager Lock

With earlier versions of BayRS, you enabled the user/manager lock using the 
Technician Interface only. You can now enable it using the BCC or Site Manager. 
The lock is disabled by default, allowing access by all users with the user or 
manager profile, and also by individual users with a unique profile. You enable the 
lock when both the RADIUS client and server are available. You disable the lock 
if the RADIUS server is not available, allowing the user to log in with the manager 
or user profile.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
select Protocols > Global Protocols > 
RADIUS > Create RADIUS.

The RADIUS Client Parameters window 
opens. The window lists the slots that 
already have RADIUS configured on 
them.

2. Click on Add. For multislot routers, the RADIUS Slot 
Selection window opens. For single-slot 
routers, the RADIUS Client Parameters 
window opens. Go to step 4.

3. Enter the slot number on which you want 
to configure RADIUS and click on OK.

The RADIUS Client Parameters window 
opens.

4. Set the following parameters:
• Authentication
• Accounting
• Client IP Address
• Debug Message Level
Click on Help or see the parameter 
descriptions beginning on page A-18.

5. Click on OK. You return to the RADIUS Client 
Parameters window.
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When you enable the user/manager lock and a RADIUS server is unavailable for 
authentication, the router automatically disables the user/manager lock. When the 
RADIUS server becomes available, the router automatically enables the 
user/manager lock.

Using the BCC

To restrict access to individual users only, navigate to the access prompt (for 
example, box; access) and enter:

user-manager-lock enable

To allow access by all users with the manager or user profile, in addition to users 
with a unique profile, navigate to the access prompt (for example, box; access) 
and enter:

user-manager-lock disable

Using Site Manager

To restrict access to individual users only, complete the following tasks:

Note: Be sure to configure RADIUS and assign the appropriate access to 
individuals with unique profiles before you enable the user/manager lock; 
otherwise you may lock out system managers from the router. 

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols > Global Protocols > 
RADIUS > Access Control.

The RADIUS Access Control window 
opens.

2. Set the User Manager Lock parameter to 
Enable. For more information, click on 
Help or see the parameter descriptions 
beginning on page A-20.

3. Click on OK. You return to the Configuration Manager 
window.
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Login Accounting

BayRS RADIUS accounting is now supported for console and Telnet router 
logins. The following sections, new to Configuring RADIUS, describe the 
functionality that was added to support this feature.

You determine whether a console or Telnet login session should allow RADIUS 
accounting messages to be sent to the RADIUS server by enabling or disabling 
RADIUS accounting access to the server.

Using the BCC

To allow RADIUS accounting messages to be sent to the RADIUS server, 
navigate to the access prompt (for example, box; access) and enter:

user-access-radius-account-enable enable

To prevent RADIUS accounting messages from being sent to the RADIUS server, 
navigate to the access prompt (for example, box; access) and enter:

user-access-radius-account-enable disable

Note: If you enable login accounting, and the RADIUS server becomes 
unavailable, the value for the user-access-radius-account-enable parameter 
is automatically set to “serverwait.” When the RADIUS server becomes 
available again, the value reverts to enabled.
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Using Site Manager

To allow RADIUS accounting messages to be sent to the RADIUS server, 
complete the following tasks:

Using SecurID for RADIUS Authentication

This section in Configuring RADIUS incorrectly states that Nortel Networks 
implements SecurID on ARN* routers only. Nortel Networks implements 
SecurID on all router platforms that operate as RADIUS clients.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols > Global Protocols > 
RADIUS > Access Control.

The RADIUS Access Control window 
opens.

2. Set the Login Accounting parameter to 
Enable. For more information, click on 
Help or see the parameter descriptions 
beginning in page A-20.

3. Click on OK. You return to the Configuration Manager 
window.
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Chapter 11
Using the Technician Interface Scripts

Version 15.1.0.0

The Technician Interface is a command-line interface that Nortel Networks 
support technicians can use to troubleshoot and configure Nortel Networks 
devices.

The following section is an amendment to Using the Technician Interface Scripts:

Using Scripts and Aliases to Dynamically Configure a Router

Use of rapid-fire scripts or aliases to dynamically set a router’s configuration via 
the MIBs can put the router into a corrupted state and cause connectivity issues. 
When you use the Technician Interface to launch scripts or aliases to configure the 
router be sure to include pauses (one to two seconds) to allow sufficient time for 
the router to make the required changes to the MIBs.
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Chapter 12
Using the Technician Interface Software

Version 15.1.0.0

The Technician Interface is a command-line interface that Nortel Networks 
support technicians can use to troubleshoot and configure Nortel Networks 
devices.

The following sections are amendments to Using the Technician Interface 
Software:

Diagnostics On/Off Option for ARN, Passport 2340, and Passport 5430

For ARN, Passport 2430 and Passport 5430 platforms only, the Technician 
Interface diags command supports an option to enable or disable diagnostics, 
effective the next time you cycle power on the router. Disabling the diagnostics 
results in a faster boot time, but leaves the hardware components unverified. The 
syntax for this option is as follows:

diags [- on|off] [<slot_id>]

Setting Default Route Cost Using the Technician Interface

When the routing table does not contain the route to a particular destination 
address, the router looks for a default route. As it does for any other route, the 
routing table either acquires the default route dynamically (through a routing 
protocol), or you can enter the default route statically.
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You can use the Technician Interface to set the wfRipIntfDefaultRouteCost (RIP 
default route cost) MIB attribute. This attribute interacts with the Site Manager 
parameter Default Route Supply or BCC parameter default-supply in one of two 
ways:

• If you select Enable for Default Route Supply or default-supply, RIP 
advertises the default route cost you set for wfRipIntfDefaultRouteCost 
attribute plus the default route learned from the network.

• If you select Generate for Default Route Supply or default-supply, RIP 
advertises the default route cost you set for wfRipIntfDefaultRouteCost.

For additional information, see “Supplying a Default Route on an Interface” in 
Configuring IP, ARP, RARP, RIP and OSPF Services. 

With the Technician Interface, enter the following commands to set the 
wfRipIntfDefaultRouteCost (RIP default route cost) attribute:

set wfRipIntfDefaultRouteCost <value>

value is any integer from 0 through 15. The default value is 1.

commit

save config <vol>: <filename>

You must have Manager access to issue a set command. The commit command 
causes the changes you made to the configuration to take effect in active memory, 
but not in flash memory. The save config command saves changes to a 
configuration file (config) and flash volume on the router.

Version 15.4.0.0

The following section describes how to enable the daylight savings time feature 
for the router using the Technician Interface.

Setting Daylight Savings Time Using the Technician Interface

Daylight savings time is the time during which clocks are set one hour or more 
ahead of standard time to provide more daylight at the end of the working day 
during late spring, summer, and early fall. In the United States, we set the clock 
ahead one hour at 2:00 am on the first Sunday in April and set the clock back one 
hour at 2:00 am on the last Sunday in October. 
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When you enable the daylight savings time feature using the Technician Interface, 
the router’s internal clock automatically sets itself one hour ahead at 2:00 am on 
the first Sunday in April and sets itself back one hour at 2:00 am on the last 
Sunday in October. Currently, only four time zones are supported: Eastern, 
Central, Mountain, and Pacific.

To enable the daylight savings time feature, enter the following command at the 
Technician Interface prompt:

set wfSys.wfSysDaylightSaving.0 1; commit

Removing the Technician Interface Login Banner

You can now replace or modify the login banner and prompt presented via a telnet 
connection or on the router console. The method uses the placement of an optional 
text file on the router flash, named “oem.txt.” If this file is present when a 
Technician Interface initializes for a potential login from console or via telnet, its 
contents govern the nature of the login banner. This file can be used for explicit 
identification purposes (positive indication that the desired system has be 
reached), security concerns (a nonspecific banner to avoid aiding unauthorized 
accesses), or cosmetic reasons. 

The rules are as follows:

• By default, in the absence of the file “oem.txt,” the login banner and prompt 
appear as follows:

Nortel Networks, Inc. and its Licensors. 
Copyright 1992,1993,1994,1995,1996,1997,1998,1999,2000,2001,2002.
All rights reserved.

Login:

• If the file “oem.txt” is present, its contents replace only the “Nortel Networks, 
Inc.” portion of the banner:

Chicken Delight - We Deliver!! and its Licensors.
Copyright 1992,1993,1994,1995,1996,1997,1998,1999,2000,2001,2002.
All rights reserved.

Login: 

• If the contents of “oem.txt” begin with the string "*NO BANNER*" 
(excluding quotes), the login banner is suppressed, but prompt is retained:

Login: 
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• If the "*NO BANNER*" string is followed by nonblank characters, they 
become the banner/prompt:

Enter user name:

Note: While changes to the “oem.txt” file will be reflected when the next 
telnet connection is established, the change to the console login banner/prompt 
will not take effect until the next system reset. 
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Chapter 13
Configuring Traffic Filters and Protocol

Prioritization

Version 15.4.0.0

The following section is new to Configuring Traffic Filters and Protocol 
Prioritization.

Configuring IP Outbound Traffic Filters Using the BCC

Outbound traffic filters act on packets that the router forwards to a local area 
network (LAN) or (WAN) through a particular interface. Protocol prioritization 
allows the router to sort traffic into prioritized delivery queues (high, normal, 
low). These queues affect the sequence in which data leaves an interface. You can 
create outbound traffic filters for the following interfaces: ATM, Ethernet 
(10Base-T or 100 Base-T), FDDI, token ring, HSSI, MCE1, MCT1, FT1/FE1, and 
synchronous. The BayRS version 15.4.0.0 implementation of this feature has the 
following limitations:

• Supports traffic with IP headers only

• Allows you to create traffic filters only; the ability to create templates is not 
available with BayRS 15.4.0.0

• Does not allow you to change the order of precedence for outbound filters

• Is not supported on X.25 interfaces

• Is not supported on Data Link Switching (DLSw) interfaces
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The following sections describe how to use the BCC to enable protocol 
prioritization and configure outbound traffic filters.

You implement protocol prioritization by applying an outbound traffic filter that 
includes a prioritizing (priority queue) action. This type of outbound traffic filter 
is called a priority filter. The next section describes how to edit protocol 
prioritization parameters that affect the way priority filters work.

Configuring Protocol Prioritization

To configure priority queues with default values, do the following:

1. Configure protocol priority on the circuit, as described in this section.

2. Apply outbound traffic filters with prioritizing action to the circuit, as 
described in “Creating Outbound Traffic Filters,” later in this chapter.

To configure protocol priority, navigate to the interface prompt (for example, box; 
ethernet/2/1) and enter: 

protocol-priority

For example, the following command configures protocol priority on connector 1 
of an ethernet module installed in slot 2:

ethernet/2/1# protocol-priority
protocol-priority/ethernet/2/1#

Displaying Protocol Priority Parameter Values

To view the current values of the protocol-priority parameters, navigate to the 
protocol priority prompt (for example, box; ethernet/2/1; protocol-priority) and 
enter:

info

Topic Page

Configuring Protocol Prioritization 13-2

Customizing Protocol Prioritization 13-3

Creating Outbound Traffic Filters 13-8
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For example, the following command shows the current parameter values for 
Protocol Priority:

protocol-priority/ethernet/2/1# info
dequeue-at-line-rate disabled
high-queue-percentage-bandwidth 70
high-queue-size 20
high-water-packets-clear 0
low-queue-percentage bandwidth 10
low-queue-size 20
max-high-queue-latency 250
normal-queue-percentage-bandwidth 20
normal-queue-size 20
prioritization-algorithm-type bandwidth-allocation
state enabled

protocol-priority/ethernet/2/1#

Customizing Protocol Prioritization

When you configure Protocol Priority on a circuit, the router uses default values 
that help determine how priority filters work. These defaults are designed to work 
well for most configurations. However, you can customize protocol prioritization 
to maximize its impact on your network.

For information about when you’d want to customize Protocol Prioritization, see 
Chapter 2 in Configuring Traffic Filters and Protocol Prioritization.

To customize Protocol Prioritization parameters, use the following procedures:.

Procedure Page

Displaying Protocol Priority Parameter Values 13-2

Enabling or Disabling Protocol Priority 13-4

Specifying the High Queue Size 13-4

Specifying the Normal Queue Size 13-5

Specifying the Low Queue Size 13-5

Specifying the Maximum High Queue Latency 13-5

Clearing the High Water Marks 13-6

Selecting the Prioritization Algorithm Type 13-6

Selecting the High Queue Percentage Bandwidth 13-7

Selecting the Normal Queue Percentage Bandwidth 13-7
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Enabling or Disabling Protocol Priority

When you configure Protocol Priority on a circuit, it is enabled by default. To 
disable Protocol Priority, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

state disabled

If you set this parameter to disabled, all outbound traffic filters will be disabled on 
this interface. Setting this parameter to disabled is useful if you want to 
temporarily disable all outbound traffic filters rather than delete them.

To re-enable Protocol Priority, navigate to the protocol priority prompt (for 
example, box; ethernet/2/1; protocol-priority) and enter:

state enabled

For example, the following command enables Protocol Priority on the selected 
circuit:

protocol-priority/ethernet/2/1# state enabled
protocol-priority/ethernet/2/1#

Specifying the High Queue Size

To specify the maximum number of packets in the High queue at any one time, 
regardless of packet size, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

high-queue-size <value>

value is any integer value; the default is 20.

For example, the following command changes the high queue size to 50:

protocol-priority/ethernet/2/1# high-queue-size 50
protocol-priority/ethernet/2/1#

Selecting the Low Queue Percentage Bandwidth 13-8

Controlling the Dequeuing of Packets 13-8

Procedure Page
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Specifying the Normal Queue Size

To specify the maximum number of packets in the Normal queue at any one time, 
regardless of packet size, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

normal-queue-size <value>

value is any integer value; the default is 20 (200 for Frame Relay).

For example, the following command changes the normal queue size to 50:

protocol-priority/ethernet/2/1# normal-queue-size 50
protocol-priority/ethernet/2/1#

Specifying the Low Queue Size

To specify the maximum number of packets in the Low queue at any one time, 
regardless of packet size, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

low-queue-size <value>

value is any integer value; the default is 20.

For example, the following command changes the low queue size to 50:

protocol-priority/ethernet/2/1# low-queue-size 50
protocol-priority/ethernet/2/1#

Specifying the Maximum High Queue Latency

To specify the greatest delay that a high-priority packet can experience and, 
consequently, how many normal-priority or low-priority bits can be in the transmit 
queue at any one time, navigate to the protocol priority prompt (for example, box; 
ethernet/2/1; protocol-priority) and enter:

max-high-queue-latency <value>

value is between 100 to 5000 ms, inclusive. The default is 250 ms. Nortel 
Networks recommends accepting the default value of 250 ms.

For example, the following command changes the maximum high queue latency 
to 500:

protocol-priority/ethernet/2/1# max-high-queue-latency 500
314470-15.4 Rev 00 13-5



BayRS Version 15.4.0.0 Document Change Notice
protocol-priority/ethernet/2/1#

Clearing the High Water Marks

When you change the queue depth (by changing the value of the high queue, 
normal queue, or low queue size), you can also reset the high-water mark by 
changing the value of this parameter. When you change the value of this 
parameter, you reset the high-water mark for all three queues to zero.

To clear the existing high-water marks, navigate to the protocol priority prompt 
(for example, box; ethernet/2/1; protocol-priority) and enter:

high-water-packets-clear <value>

value is any integer value; the default is 0.

For example, the following command clears the existing high-water marks for the 
priority queues:

protocol-priority/ethernet/2/1# high-water-packets-clear 1
protocol-priority/ethernet/2/1#

Selecting the Prioritization Algorithm Type

To select the dequeuing algorithm that protocol prioritization uses to drain priority 
queues and transmit traffic, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

prioritization-algorithm-type {bandwidth-allocation | strict}

If you select strict queueing, the router always transmits traffic in the High queue 
before transmitting traffic in the other queues. If you accept the default, bandwidth 
allocation queueing, the router transmits traffic in a queue until the utilization 
percentage for that queue is reached; then, the router transmits traffic in the 
next-lower-priority queue. (You configure the percentages for bandwidth 
allocation by setting the high-queue, normal-queue, and low-queue percentage 
bandwidth parameters).

For example, the following command changes the dequeuing algorithm to strict:

protocol-priority/ethernet/2/1# prioritization-algorithm-type strict
protocol-priority/ethernet/2/1#
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Selecting the High Queue Percentage Bandwidth

If you selected the bandwidth allocation dequeuing algorithm, to specify the 
percentage of the synchronous line’s bandwidth allocated to traffic that has been 
sent to the High queue, navigate to the protocol priority prompt (for example, box; 
ethernet/2/1; protocol-priority) and enter:

high-queue-percentage-bandwidth <percent>

percent is a value between 0 to 100, inclusive. The default is 70 percent. When 
you set this parameter to a value less than 100, each time the percentage of 
bandwidth used by high-priority traffic reaches this limit, the router transmits 
traffic in the Normal and Low queues, up to the configured percentages for those 
priority queues. The high queue, normal queue, and low queue percentage 
bandwidth values must total 100.

For example, the following command changes the high queue percentage 
bandwidth to 50 percent:

protocol-priority/ethernet/2/1# high-queue-percentage-bandwidth 50
protocol-priority/ethernet/2/1#

Selecting the Normal Queue Percentage Bandwidth

If you selected the bandwidth allocation dequeuing algorithm, to specify the 
percentage of the synchronous line’s bandwidth allocated to normal-priority 
traffic, navigate to the protocol priority prompt (for example, box; ethernet/2/1; 
protocol-priority) and enter:

normal-queue-percentage-bandwidth <percent>

percent is a value between 0 to 100, inclusive. The default is 20 percent. The high 
queue, normal queue, and low queue percentage bandwidth values must total 100.

For example, the following command changes the normal queue percentage 
bandwidth to 30 percent:

protocol-priority/ethernet/2/1# normal-queue-percentage-bandwidth 
30
protocol-priority/ethernet/2/1#
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Selecting the Low Queue Percentage Bandwidth

If you selected the bandwidth allocation dequeuing algorithm, to specify the 
percentage of the synchronous line’s bandwidth allocated to low-priority traffic, 
navigate to the protocol priority prompt (for example, box; ethernet/2/1; 
protocol-priority) and enter:

low-queue-percentage-bandwidth <percent>

percent is a value between 0 to 100, inclusive. The default is 10 percent. The high 
queue, normal queue, and low queue percentage bandwidth values must total 100.

For example, the following command changes the low queue percentage 
bandwidth to 20 percent:

protocol-priority/ethernet/2/1# low-queue-percentage-bandwidth 20
protocol-priority/ethernet/2/1#

Controlling the Dequeuing of Packets

To control the dequeuing of packets from the queues to the driver, navigate to the 
protocol priority prompt (for example, box; ethernet/2/1; protocol-priority) and 
enter:

dequeue-at-line-rate {disabled | enabled}

When limited bandwidth is available, select enabled to reduce delay in queues that 
need a constant delay rate, such as Voice over IP. Accept the default, disabled, if 
you do not need constant bandwidth for traffic that requires a constant delay rate.

For example, the following command enabled the dequeue-at-line-rate feature:

protocol-priority/ethernet/2/1# dequeue-at-line-rate enabled
protocol-priority/ethernet/2/1#

Creating Outbound Traffic Filters

You can create outbound traffic filters for the following interfaces: Ethernet 
(10Base-T or 100BASE-T), FDDI, token ring, HSSI, MCE1, MCT1, and 
synchronous. The current implementation of this feature supports only traffic with 
IP headers. The following section describes how to create an IP-routed outbound 
traffic filter for an interface.
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To create outbound traffic filters, use the following procedures:

Creating a Filter for IP-Routed Packets

To create an outbound traffic filter for IP-routed packets, navigate to the protocol 
priority prompt (for example, box; serial/3/1; protocol-priority) and enter:

ip-outbound-filter <filter_name>

filter_name is a descriptive name for the filter. For example, use the name 
drop_telnet_s31 for a filter that drops outbound Telnet traffic on a serial module in 
slot 3, connector 1.

For example, the following command creates an outbound filter with the name 
drop_telnet_s31:

protocol-priority/serial/3/1# ip-outbound-filter drop_telnet_s31
ip-outbound-filter/drop_telnet_s31/S31#

Displaying Priority Outbound Filter Parameter Values

To view the current values of the outbound filter, navigate to the traffic filter 
prompt (for example, box; serial/3/1; protocol-priority; ip-outbound-filter 
<filter_name>) and enter:

info

For example, the following command shows the current parameter values for the 
priority outbound filter:

Procedure Page

Creating a Filter for IP-Routed Packets 13-9

Displaying Priority Outbound Filter Parameter Values 13-9

Enabling or Disabling the Outbound Filter 13-10

Specifying Match Criteria for IP-to-IP Outbound Traffic Filters 13-10

Specifying Match Criteria for IP-to-Source Routing Outbound Traffic Filters 13-17

Specifying Match Criteria for IP-to-PPP Outbound Traffic Filters 13-18

Specifying Match Criteria for IP-to-Frame Relay Outbound Traffic Filters 13-18

Specifying the Action of Outbound Traffic Filters 13-19

Specifying User-Defined Criteria 13-24
314470-15.4 Rev 00 13-9



BayRS Version 15.4.0.0 Document Change Notice
ip-outbound-filter/drop_telnet_s31/S31# info
filter-name drop_telnet_s31
state enabled

ip-outbound-filter/drop_telnet_s31/S31#

Enabling or Disabling the Outbound Filter

When you create an outbound filter on a circuit, it is enabled by default. To disable 
the filter, navigate to the traffic filter prompt (for example, box; serial/3/1; 
protocol-priority; ip-outbound-filter <filter_name>) and enter:

state disabled

If you set this parameter to disabled, the specified outbound traffic filter will be 
disabled on this interface. Setting this parameter to disabled is useful if you want 
to temporarily disable the outbound traffic filter rather than delete it.

To re-enable the outbound filter, navigate to the traffic filter prompt (for example, 
box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>) and enter:

state enabled

For example, the following command enables the outbound filter on the selected 
circuit:

ip-outbound-filter/drop_telnet_s31/S31# state enabled
ip-outbound-filter/drop_telnet_s31/S31#

Specifying Match Criteria for IP-to-IP Outbound Traffic Filters

The match criteria in a filter specify which fields in the IP header of each packet 
must contain the values that you specify. You can also specify certain fields in the 
headers of TCP and UDP packets contained in the IP data field of IP packets. 

To prepare to specify the filtering criteria, navigate to the traffic filter prompt (for 
example, box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>) 
and enter:

match-ip-ip
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You can specify match criteria for filters as described in the following sections:

Specifying Source and Destination Networks As Match Criteria

To filter on source and destination networks, go to the match-ip-ip prompt (for 
example, (for example, box; serial/3/1; protocol-priority; ip-outbound-filter 
<filter_name>); match-ip-ip) and do the following for each source and destination 
network that you want to filter on:

1. Enter the following command:

{source | destination}-network <address_range>

<address_range> specifies a range of IP addresses for source and destination 
networks. 

The source network or destination network prompt appears.

2. Go back to the match-ip-ip prompt:

back

Example 

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# source-network 
2.2.2.2-4.4.4.4 
source-network/ip-outbound-filter/drop_telnet_s31/S31/
2.2.2.2-4.4.4.4# back
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
destination-network 4.4.4.4-5.5.5.5
destination-network/ip-outbound-filter/drop_telnet_s31/S31/
4.4.4.4-5.5.5.5# back
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#
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Specifying Source and Destination TCP and UDP Ports As Match Criteria

To filter on TCP ports, UDP ports, or both, you can specify only one of the 
following criteria for each filter:

• Source TCP ports, destination TCP ports, or both

• Source UDP ports, destination UDP ports, or both

• Both destination TCP and UDP ports

• Both source TCP and UDP ports

After you specify one of these options, the BCC prevents you from specifying 
another in the same filter. For example, if you specify source TCP ports, you can 
also specify destination TCP ports, but you cannot specify source UDP ports.

When you specify one of these values, the BCC automatically assigns the 
associated protocol ID (6 for TCP or 17 for UDP) to the protocol parameter. 
Therefore, you cannot modify the protocol parameter of a filter that specifies a 
TCP or UDP port value.

To filter on TCP or UDP ports, navigate to the match-ip-ip prompt (for example, 
box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>); 
match-ip-ip) and enter the following command: 

<parameter> {<range_of_ports>}

parameter is one of the following (Table 13-1):

Table 13-1. TCP and UDP Match Criteria Parameters

Parameter Specifies

pri-ip-ip-src-tcp-ports Source TCP port through which traffic is exiting the 
network

pri-ip-ip-dest-tcp-ports Destination TCP port through which traffic is entering 
the network

pri-ip-ip-src-udp-ports Source UDP port through which traffic is exiting the 
network

pri-ip-ip-dest-udp-ports Destination UDP port through which traffic is entering 
the network
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range_of_ports is a space-delimited list.

Table 13-2 lists some common TCP port values. 

Table 13-3 lists some common UDP port values.

pri-ip-ip-dest-tcp-udp-ports Both destination TCP and UDP ports through which 
traffic is entering the network

pri-ip-ip-src-tcp-udp-ports Both source TCP and UDP ports through which traffic is 
exiting the network

Table 13-2. Common TCP Ports

Description TCP Port

FTP 20, 21

Telnet 23

SMTP 25

DNS 53

Gopher 70

World Wide Web http 80-84

DLSw read port 2065

DLSw write port 2067

Table 13-3. Common UDP Ports

Description UDP Port

DNS 53

TFTP 69

SNMP 161

SNMPTRAP 162

Table 13-1. TCP and UDP Match Criteria Parameters

Parameter Specifies
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Example - Source TCP Port

This example specifies source TCP ports 20, 80, and 53 through 56 as match 
criteria for the filter template telnet-in:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-src-tcp-ports {20 80 53-56}
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Example - Destination TCP Port

This example specifies destination TCP ports 30, 90, and 50 through 53 as match 
criteria: 

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-dest-tcp-ports {30 90 50-53}
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Example - Source UDP Port

This example specifies source UDP port 162 as match criteria:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-src-udp-ports 162
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 

Example - Destination UDP Port

This example specifies destination UDP port 69 as match criteria:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-dest-udp-ports 69
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 

Example - Destination TCP and UDP Ports

This example specifies both destination TCP and UDP ports 53 as match criteria:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-dest-tcp-udp-ports 53
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Example - Source TCP and UDP Ports

This example specifies both source TCP and UDP ports 53 as match criteria:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-src-tcp-udp-ports 53
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
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Specifying Protocol Identifiers As Match Criteria

Internet Protocol Version 4 (IPv4) specifies an 8-bit protocol field to identify the 
next-level protocol. You can use the protocol field to identify traffic that you want 
to accept or drop.

If you specify a protocol other than TCP or UDP, the software prevents you from 
filtering on the TCP or UDP source or destination. Otherwise, the offset 
associated with one of the parameters in the non-UDP/TCP packet could 
coincidentally match the filter, and the software would perform the filter’s action.

To filter traffic using the protocol field, navigate to the match-ip-ip prompt (for 
example, box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>); 
match-ip-ip) and enter the following command:

pri-ip-ip-protocol {<list_of_protocols>}

list_of_protocols can include any number of protocol identifiers. It can also 
specify ranges of protocol identifiers.

Table 13-4 lists some common protocol ID codes for IP traffic.

Note: If you filter on a TCP or UDP source or destination, the software 
automatically changes the value to the protocol number associated with TCP 
or UDP.

Table 13-4. Common Protocol IDs for IP Traffic

Protocol  ID Code (Decimal)

ICMP (Internet Control Message Protocol) 1

IGMP (Internet Group Management Protocol) 2

TCP (Transmission Control Protocol) 6

EGP (Exterior Gateway Protocol) 8

IGP (Interior Gateway Protocol) 9

UDP (User Datagram Protocol) 17

RSVP (Resource Reservation Protocol) 46

GRE (Generic Routing Encapsulation) 47

NHRP (Next Hop Resolution Protocol) 54

OSPF (Open Shortest Path First) 89
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Example

To match IGP packets, enter the following command:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-protocol 9
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Specifying the Type of Service (ToS) As Match Criteria

You can discriminate higher priority traffic from lower priority traffic by 
specifying the type of service as the matching criteria for the traffic filter. 

To specify the type of service portion of the IP header, enter the following 
command at the match-ip-ip prompt (for example, box; serial/3/1; 
protocol-priority; ip-outbound-filter <filter_name>); match-ip-ip) and enter:

pri-ip-ip-tos {<list_of_values>}

list_of_values is a space-delimited list. It can be any number of values from 0 
through 65,535. It can also specify ranges of values. Use a dash instead of a space 
to indicate a range. 

Example

In this example, the router matches packets whose ToS bit is set to 1. 

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# pri-ip-ip-tos 1
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Specifying TCP-Established Match Criteria

By default, the router does not filter packets on the ACK and RESET bits in the 
TCP header. To allow the router to filter packets with the ACK and RESET bits, 
go to the match-ip-ip prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); match-ip-ip) and enter the following 
command:

pri-ip-ip-tcp-established {on | off}
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Example

In this example, the router filters packets with the ACK and RESET bits in the 
TCP header turned on.

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-tcp-established on
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Specifying Match Criteria for IP-to-Source Routing Outbound Traffic 
Filters

To prepare to specify the filtering criteria, navigate to the match-ip-ip prompt (for 
example, box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>; 
match-ip-ip) and enter:

match-ip-source-routing

Specifying SSAPs as Match Criteria

To filter on a range of session service access points (SSAPs), navigate to the 
match-ip-source-routing prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); match-ip-ip; match-ip-source-routing) and 
enter the following command: 

pri-ip-sr-ssap <range>

range specifies any number of session service access points (SSAPs). It can 
also specify ranges of SSAPs. 

Specifying Source and Destination Networks As Match Criteria

To filter on source and destination networks, go to the match-ip-source-routing 
prompt (for example, (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); match-ip-ip; match-ip-source-routing) and 
enter the following command for each source and destination network that you 
want to filter on:

{pri-ip-sr-src | pri-ip-sr-dest}-addr <address_range>

<address_range> specifies a range of addresses for source and destination 
networks. 
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Example 

match-ip-source-routing/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-sr-src-addr 2.2.2.2-4.4.4.4
pri-ip-sr-src-addr/ip-outbound-filter/drop_telnet_s31/S31/
2.2.2.2-4.4.4.4# back
match-ip-source-routing/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-sr-dest-addr 4.4.4.4-5.5.5.5
pri-ip-sr-dest-addr/ip-outbound-filter/drop_telnet_s31/S31/
4.4.4.4-5.5.5.5# back
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Specifying Match Criteria for IP-to-PPP Outbound Traffic Filters

To prepare to specify the filtering criteria, navigate to the match-ip-ip prompt (for 
example, box; mct1 4/1; logical-line <MCT_line_no>; protocol-priority; 
ip-outbound-filter <filter_name>; match-ip-ip) and enter:

match-ip-ppp

Specifying Protocol IDs as Match Criteria

To filter on a range of protocol IDs, navigate to the match-ip-ppp prompt (for 
example, box; mct1 4/1; logical-line <MCT_line_no>; protocol-priority; 
ip-outbound-filter <filter_name>; match-ip-ip; match-ip-ppp) and enter the 
following command: 

pri-ip-ppp-protocol-id <list_of_protocols>

list_of_protocols can include any number of protocol identifiers. It can also 
specify ranges of protocol identifiers.

Specifying Match Criteria for IP-to-Frame Relay Outbound Traffic 
Filters

To prepare to specify the filtering criteria for IP-to-frame-relay outbound filters, 
navigate to the match-ip-ip prompt (for example, box; mct1 4/1; logical-line 
<MCT_line_no>; protocol-priority; ip-outbound-filter <filter_name>; 
match-ip-ip) and enter:

match-ip-frame-relay
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Specifying DLCIs as Match Criteria

To filter on a range of DLCIs, navigate to the match-ip-frame-relay prompt (for 
example, box; mct1 4/1; logical-line <MCT_line_no>; protocol-priority; 
ip-outbound-filter <filter_name>; match-ip-ip; match-ip-frame-relay) and enter 
the following command: 

pri-ip-fr-{dlci2byte | dlci3byte |dlci4byte} <byte_range>

byte_range specifies the PVC identification number (used by the frame relay 
network to direct data) or ranges of numbers on which you want to filter outbound 
traffic. 

For the 2-byte DLCI address field, the valid values are 16 to 1007. Enter the 
decimal number that the frame relay provider assigns. 

For the 3-byte DLCI address field, the valid values are 1024 to 64511. Enter the 
decimal number that the frame relay provider assigns. 

For the 4-byte DLCI address field, the valid values are 131072 to 4194303. Enter 
the decimal number that the frame relay provider assigns. 

Specifying NLPIDs as Match Criteria

To filter on a range of NLPIDs, navigate to the match-ip-frame-relay prompt (for 
example, box; mct1 4/1; logical-line <MCT_line_no>; protocol-priority; 
ip-outbound-filter <filter_name>; match-ip-ip; match-ip-frame-relay) and enter 
the following command: 

pri-ip-fr-nlpid <nlpid_range>

nlpid_range specifies any number of network layer protocol identifiers 
(NLPIDs). It can also specify ranges of NLPIDs. 

Specifying the Action of Outbound Traffic Filters

For outbound traffic filters, you can specify different types of action:

• Filtering Actions

• Prioritizing Actions

• Dial Service Actions
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Filtering Actions

The filter action determines what happens to packets that match the filter criteria. 
You can configure IP outbound traffic filters to perform the following actions:

• Accept

The router processes any packet that matches the filter criteria and ranges.

• Drop

The router does not route any packet that matches the filter criteria and ranges.

• Log

For every packet that matches the filter criteria, the router sends an entry to 
the system event log. You can specify the log action in combination with other 
actions.

To specify an action, navigate to the actions prompt (for example, box; serial/3/1; 
protocol-priority; ip-outbound-filter <filter_name>); actions) and enter:

action {accept | drop}

For example, to change the action to drop, enter the following command:

actions/ip-outbound-filter/drop_telnet_s31/S31# action drop
actions/ip-outbound-filter/drop_telnet_s31/S31#

To log an entry to the system Events log for every packet that matches the filter 
criteria and ranges, navigate to the ip-outbound-filter prompt (for example, box; 
serial/3/1; protocol-priority; ip-outbound-filter <filter_name>) and enter:

action-log on

For example, to log entries to the Events log, enter the following command:

actions/ip-outbound-filter/drop_telnet_s31/S31# action-log on
actions/ip-outbound-filter/drop_telnet_s31/S31#

The default value for this parameter is off.

Note: Specify the Log action to record abnormal events only; otherwise, the 
Events log will fill up with filtering messages, leaving no room for critical log 
messages.
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Prioritizing Actions

You can apply the following actions to outbound traffic filters for WAN protocols:

• High 

Directs packets that match the filter criteria and ranges to the High queue

• Low 

Directs packets that match the filter criteria and ranges to the Low queue

• Length 

Uses the length of packets to determine the priority queue

Outbound traffic filters with a prioritizing action are called priority filters. 

To direct packets that match the filter criteria and ranges to the High queue, 
navigate to the actions prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); actions) and enter:

action high-queue

To direct packets that match the filter criteria and ranges to the Low queue, 
navigate to the actions prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); actions) and enter:

action low-queue

To use the length of packets to determine the priority queue, navigate to the 
actions prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); actions), and use the following procedure:

1. Enter the following command:

action length

The actions prompt is re-displayed (e.g., actions/ip-outbound-filter/test/S31#)

Note: You can apply prioritizing actions only to MCE1, MCT1, and 
synchronous interfaces. The BCC does not support priority filters on the LAN 
interfaces.
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2. At the actions prompt, enter:

prioritization-length

The prioritization-length prompt is displayed (e.g., prioritization-length/
ip-outbound-filter/test/S31#)

3. Enter one of the following commands:

{greater-than-queue <greater_than_queue_value> | less-than-or 
equal-queue <less_than_or_equal_queue_value> | packet-length 
<packet_length_value>}

greater_than_queue_value specifies which queue a packet is placed in if its 
packet length is greater than the value of the packet-length parameter. Valid 
values are high, low, or normal.

less_than_or_equal_queue_value specifies which queue a packet is placed in 
if its packet length is less than or equal to the value of the packet-length 
parameter. Valid values are high, low, or normal.

packet_length_value defines a packet length measurement to which each 
packet is compared. An action is imposed on every packet, depending on 
whether it is less than, equal to, or greater than the value you set for this 
parameter. This action depends on the values of the less-than-or-equal-queue 
and the greater-than-queue parameters. Enter a packet length value in bytes (0 
to 4608). The default is 256. 

Example

This example specifies that packets with lengths greater than 156 bytes are placed 
in the normal queue and that packets with lengths less than or equal to 156 bytes 
are placed in the high queue.

actions/ip-outbound-filter/drop_telnet_s31/S31# action length
actions/ip-outbound-filter/drop_telnet_s31/S31# prioritization-length
prioritization-length/ip-outbound-filter/drop_telnet_s31/S31# 
greater-than-queue normal
prioritization-length/ip-outbound-filter/drop_telnet_s31/S31# 
less-than-or-equal-queue high
prioritization-length/ip-outbound-filter/drop_telnet_s31/S31# 
packet-length 156
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Dial Service Actions

You can apply the following actions to outbound traffic filters for interfaces 
configured as dial-up lines:

• No Call 

Packets that match the filter criteria and ranges are dropped and do not initiate 
a dial connection. (By default, packets transmitted on dial-on-demand lines 
always trigger the router to establish a connection.)

• No Reset 

Packets that match the filter criteria and ranges are processed but do not reset 
the inactivity timer.

To enable the no-call feature, navigate to the actions prompt (for example, box; 
serial/3/1; protocol-priority; ip-outbound-filter <filter_name>; actions) and 
enter:

no-call on

For example, to drop packets that match the filter criteria and ranges, enter the 
following command:

actions/ip-outbound-filter/drop_telnet_s31/S31# no-call on
actions/ip-outbound-filter/drop_telnet_s31/S31#

To enable the no-reset feature, navigate to the actions prompt (for example, box; 
serial/3/1; protocol-priority; ip-outbound-filter <filter_name>; actions) and 
enter:

no-reset on

Note: If you attempt to delete an IP traffic filter for which the action parameter 
is set to “length,” the value for that parameter changes to “accept” and the IP 
traffic filter is not deleted.

Note: Although No Call and No Reset are available when creating any 
outbound traffic filter, these actions are useful only on dial-up interfaces such 
as synchronous modem lines or MCT1 interfaces configured with ISDN PRI.
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For example, to process packets that match the filter criteria and ranges but do not 
reset the inactivity timer, enter the following command:

actions/ip-outbound-filter/drop_telnet_s31/S31# no-reset on
actions/ip-outbound-filter/drop_telnet_s31/S31#

Specifying User-Defined Criteria

You can specify user-defined criteria in IP outbound traffic filters by specifying an 
offset and length based on the reference fields in the IP header.

To specify user-defined criteria, navigate to the match prompt (for example, box; 
serial/3/1; protocol-priority; ip-outbound-filter <filter_name>); match-ip-ip) 
and enter:

user-defined reference <value> offset <value> bitwidth <value> range <value>

reference is a known bit position in the packet header. Valid values are 
ip-wan-header-start, ip-wan-header-end, x25-mac-start, x25-snap-start, 
x25-nlpid-start, x25-nlpdu-start.

offset specifies the first position of the filtered bit pattern in relation to the 
reference point (measured in bits).

bitwidth specifies the total bit length that matches the packet criteria.

range specifies a minimum and maximum target value to apply to the match 
criterion. For a single value, you must specify the minimum value in hexadecimal 
format. You can precede the value with 0x.

Example

This example specifies user-defined criteria to create an IP traffic filter that drops 
every packet that has a value of 192 at offset 96 from the beginning of the IP 
header. 

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# user-defined 
reference ip-wan-header-start offset 96 bitwidth 16 range 0192
user-defined/filter/drop_telnet_231/start-ip-header/96/16/0192# 
back
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# back
ip-outbound-filter/drop_telnet_231/S31# actions
actions/ip-outbound-filter/drop_telnet_s31/S31# action drop
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Chapter 14
Configuring VRRP Services

Version 15.3.0.0

The following section is new to Chapter 3, “Customizing VRRP” in Configuring 
VRRP Services.

Enabling or Disabling VRRP Ping

When enabled, this feature allows you to ping a master virtual router that is not the 
owner of the virtual IP address. By default, VRRP ping is disabled.

Using the BCC

To enable VRRP ping, access the virtual router (for example, box; ip; vrrp 
192.41.31.21/2 vr-ip-address 192.41.31.22) and enter:

ping-enable enabled

To disable VRRP ping, access the virtual router and enter:

ping-enable disabled

For example, to enable VRRP ping, enter the following command:

vrrp/192.41.31.21/2# ping-enable enabled
vrrp/192.41.31.21/2#
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Using Site Manager

To enable VRRP ping, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose VRRP. The IP VRRP Configuration Parameters 
window opens.

4. Click on a virtual router instance ID to 
highlight it in the list of virtual routers.

The configuration that pertains to the 
highlighted router appears.

5. Set the VRRP Address Ping parameter. 
Click on Help or see the parameter 
description on page A-22.

6. Click on Apply.

7. Click on Done. You return to the Configuration Manager 
window.
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Chapter 15
Configuring X.25 Services

Version 15.4.0.0

The following sections are new to Configuring X.25 Services:

The section “X.25 PAD” contains an amendment to Chapter 1 in Configuring X.25 
Services.

Enabling the QLLC XID Retry Feature

Some OS/2 PCs configured with QLLC service for X.25 may take 20 to 50 
seconds to become ready to respond to an XID3. Consequently, the PC ignores the 
first XID3 that it received and cannot establish a connection. QLLC can now 
retransmit the XID3 every 10 seconds to the QLLC endstation until it receives a 
response. You can enable or disable this feature using the XID Retry parameter on 
the QLLC Mapping Table Configuration window. For information about 
accessing the parameters on the QLLC Mapping Table Configuration window, see 
Configuring X.25 Services. For more information about the XID Retry parameter, 
see Appendix A.

Topic Page

Enabling the QLLC XID Retry Feature 15-1

Setting the LLC Connect Timer 15-2

Accepting Incoming X.25 Calls for QLLC Service 15-2
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Setting the LLC Connect Timer

Some IBM hosts may take several minutes to establish connections over QLLC 
service for X.25, thereby exceeding the hard-coded 25 second timeout interval for 
DLSw. You can now configure the DLSw timeout interval to values greater than 
25 seconds (up to 600 seconds), using the Technician Interface.

Accepting Incoming X.25 Calls for QLLC Service

BayRS now accepts incoming X.25 calls for QLLC service from devices that do 
not have an X.121 calling address. Only one X.25 connection can be supported at 
any given time. You can enable or disable this feature using the No Calling 
Address parameter on the X.25 Service Configuration window. For information 
about accessing the parameters on the X.25 Service Configuration window, see 
Configuring X.25 Services. For more information about the No Calling Address 
parameter, see Appendix A.

X.25 PAD

An X.25 packet assembler/disassembler (PAD) provides access to an X.25 
network for devices, often character terminals, that are not capable of sending and 
receiving traffic across the X.25 interface. The PAD establishes and maintains the 
link with the packet-switched network, assembles and disassembles packets, 
communicates with the character terminal, and handles special control processes 
for the character terminal. Bay Networks X.25 PAD services comply with the 
CCITT so-called Triple X Standards: Recommendations X.3, X.28, and X.29.

Nortel Networks X.25 PAD services work only with X.25 SVCs for the current 
software release, and only with the ARN* router. Only one ISDB per ARN is 
supported.

For instructions on installing an X.25 PAD, see Installing the X.25 PAD. For 
instructions on using Site Manager to configure X.25 PAD Services, see Chapter 7 
in Configuring X.25 Services.

Caution: The default value for wfDlsLLCConnectTime is 25 seconds. You 
should never change this value unless absolutely necessary. This value should 
not be changed unless there is a justifiable network requirement.
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Chapter 16
Quick-Starting Routers

Version 15.3.0.0

The following section contains an amendment to Chapter 10, “Installing Site 
Manager on a SPARCstation” in Quick-Starting Routers.

SPARCstation System Requirements

To run Site Manager, your SPARCstation must meet the following hardware and 
software requirements:

• Supported workstations:

-- SPARCstation 10, 20

-- UltraSPARC

• Supported operating systems: Solaris 2.7 and 2.8

• Window environment:

-- CDE 1.0.1

-- OpenWindows 3.5

• 32 MB of RAM (64 MB recommended) 

• 145 MB of disk space

• 32 MB of swap space

• Network adapter appropriate for your network

• CD-ROM drive
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The following section contains an amendment to Chapter 12, Installing Site 
Manager on an HP 9000 Workstation in Quick-Starting Routers.

HP 9000 Workstation System Requirements

To run Site Manager, your HP 9000 workstation must meet the following 
hardware and software requirements:

• Supported workstations: HP 9000 Series 700 and 800

• Supported operating systems: HP-UX 10.20 (BayRS Version 15.3.0.0 or 
greater) and HP-UX 11.00, including the complete services (network 
services) directory

• Window environment: CDE 1.0.1

• 32 MB of RAM 

• 145 MB of free disk space 

• 32 MB of swap space (64 MB recommended)

• Network adapter appropriate for your network

• CD-ROM drive
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Chapter 17
Upgrading Routers to BayRS Version 15.x

Version 15.2.0.0

The following section describes changes to Upgrading Routers to BayRS Version 
15.x.

Why You Upgrade Boot and Diagnostic PROMs

Table A-1 in “Why You Upgrade Boot and Diagnostic PROMs” of Upgrading 
Routers to BayRS Version 15.x has been modified to include the latest boot and 
diagnostic PROM file names and associated revision numbers for router platforms 
running BayRS Version 15.x.

Router
Platform

Diagnostic 
PROM
File Name 

Diagnos-
tic PROM
Revision
Number

Reason for 
Upgrading 
PROM

Boot PROM
File Name

Boot PROM 
Revision
Number

AN/ANH* andiag.exe 7.36 Strata flash fea-
ture support

anboot.exe 9.00d

ARN arndiag.exe 2.24 Strata flash fea-
ture support

arnboot.exe 1.27

arndiag.rom 2.24 Not applicable arnboot.rom 1.27

e7srom.rom 2.16 E7S feature sup-
port

isdb.rom 1.06

arn_pdbrom.rom 1.22 Not applicable
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ASN* asndiag.exe 2.36 Strata flash fea-
ture support

asnboot.exe 13.00 

asndiag.rom 2.36 Not applicable

BN* frediag.exe 5.16 Strata flash fea-
ture support

freboot.exe 13.00

fre4diag.ppc 1.14 FRE-4 board 
support

fre4boot.ppc 13.20

ARE (BN, 5782 MPE) arediag.ppc 1.22 Strata flash fea-
ture support

areboot.ppc 14.0.1.0

Passport 2430 pp2430diag.exe 2.06 Not applicable pp2430boot.ppc 14.10

pp2430ram.exe 2.06 Not applicable

pp2430diag.a 2.06 Not applicable

Passport 5430 pp5430diag.exe 1.10 Not applicable pp5430boot.ppc 15.2.0.0

pp5430ram.exe 1.10 Not applicable

pp5430diag.a 1.10 DS3/E3 feature 
support and 
quad serial 
feature support

System 5000* 
net modules

s5000diag.exe 0.04 Strata flash fea-
ture support

s5000boot.exe 13.00

Router
Platform

Diagnostic 
PROM
File Name 

Diagnos-
tic PROM
Revision
Number

Reason for 
Upgrading 
PROM

Boot PROM
File Name

Boot PROM 
Revision
Number
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Upgrading Routers to BayRS Version 15.x
Version 15.3.0.0

The following section describes changes to Upgrading Routers to BayRS Version 
15.x.

Site Manager Upgrade Prerequisites

Before you upgrade to Site Manager Version 15.x, review Site Manager system 
requirements.

Reviewing Site Manager System Requirements

Site Manager is a graphical user interface (GUI) for router configuration and 
management over an IP network. To run Site Manager Version 15.x, your PC, 
IBM* workstation, SPARCstation*, or HP* 9000 must meet the hardware and 
software requirements listed in Table 17-1.

Table 17-1. Site Manager System Requirements

Platform Hardware and Software Requirements

PC • 486 PC (Pentium recommended)
• Microsoft* Windows* 98 or 2000 (32-bit) or Windows NT* 

Version 4.0 (32-bit)
• 16 MB of RAM (minimum)
• 90 MB of free disk space 
• Microsoft TCP/IP for Windows 98 or 2000 and compatible network 

adapter and driver
• CD-ROM drive 
• VGA monitor (SuperVGA monitor recommended)

SPARCstation • Supported workstations: SPARCstation 10, 20, and UltraSPARC
• Supported operating system: Solaris 2.7 and 2.8
• Window environments: CDE 1.0.1 and OpenWindows 3.5
• 32 MB of RAM (64 MB recommended) 
• 145 MB of disk space
• 32 MB of swap space
• Network adapter appropriate for your network
• CD-ROM drive
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Version 15.4.0.0

The following sections replace the existing sections in Chapter 4 and Chapter 5, 
respectively.

Upgrading and Verifying PROMs

When you upgrade PROMs, the system erases the existing PROM image and 
copies the contents of the newer PROM image file to the PROM. To verify the 
PROM, the system compares the contents of the new image file to the actual 
contents of the PROM. See Table A-1 on page A-2 of Upgrading Routers to 
BayRS Version 15.x. for Version 15.0 boot and diagnostic PROM file names and 
associated revision numbers for all router platforms.

IBM workstation • Supported workstations: RS/6000 340, 370, and PowerPC
• Supported operating system: IBM AIX* Version 4.3
• Window environments: CDE 1.0.1 and AIX Motif 1.2
• 32 MB of RAM (64 MB recommended)
• 140 MB of disk space
• 32 MB of swap space (64 MB recommended; use 96 MB of swap 

space with the NetView for AIX application)
• Network adapter appropriate for your network
• CD-ROM drive

HP 9000 • Supported workstations: HP 9000 Series 700 and 800
• Supported operating system: HP-UX 10.20 (BayRS Version 

15.3.0.0 or greater) and HP-UX 11.00, including the complete 
network services directory

• Window environment: CDE 1.0.1
• 32 MB of RAM 
• 145 MB of free disk space 
• 32 MB of swap space (64 MB recommended)
• Network adapter appropriate for your network
• CD-ROM drive

Note: Before you upgrade any router software, make sure that you save a copy 
of the original configuration file and boot image as a safeguard in case you 
encounter problems after upgrading.

Table 17-1. Site Manager System Requirements (continued)

Platform Hardware and Software Requirements
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You use the prom command from the Technician Interface to upgrade and verify 
the software on the diagnostic or boot PROM. This command is restricted to the 
Manager access level.

To upgrade and verify PROMs on a router, begin at the Technician Interface 
prompt and complete the following steps:

1. Establish a Technician Interface session with the router.

Enter the following command at the Technician Interface prompt: 

Manager

For more information about how to open a Technician Interface session with 
the router, see Using Technician Interface Software.

2. Insert a flash card with contiguous free space sufficient to accommodate 
the PROM images that you want to transfer to the router. 

To determine the amount of contiguous free space, display the directory of the 
flash volume by entering the following command at the Technician Interface 
prompt:

dir <volume_no.>:

volume_no. is the slot in which the flash card resides.

If you need more contiguous free space for the PROM image:

a. Delete unnecessary or obsolete files.

b. Compact the contents of the flash card by entering:

compact <volume_no.>:

The following message appears:

Compacting file system on volume <vol>:... 
This may take several minutes...Please wait...
100% Complete
Compaction completed

The space is compacted when the Technician Interface prompt reappears.

c. Verify that the amount of contiguous free space and available free 
space on the volume are the same by entering:

dir <volume_no.>:
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3. Transfer the PROM image files (for example, freboot.exe and frediag.exe) 
from the Site Manager PC or workstation to the router’s flash card by 
using the tftp command.

For more information about the tftp command, see Using Technician Interface 
Software.

4. Update the boot PROM by entering:

prom -w <volume_no.>:<Boot_PROM_source_file> <slot_ID>

volume_no. is the slot number of the boot PROM source file.

Boot_PROM_source_file is the name of the boot PROM source file (for 
example, freboot.exe).

slot_ID is the slot location of the boot PROM that you want to update. 

For AN, ANH, or ARN routers, the slot_ID is always 1.

For example, enter the following command:

prom -w 2:freboot.exe 3

This command erases the boot PROM image on slot 3 and copies the contents 
of the freboot.exe file on volume 2 to the PROM on slot 3.

5. Update the diagnostic PROM by entering:

prom -w <volume_no.>:<Diag_PROM_source_file> <slot_ID>

volume_no. is the slot number of the diagnostic PROM source file.

Diag_PROM_source_file is the name of the diagnostic PROM source file (for 
example, frediag.exe).

Note: To update the boot PROM on the Passport 2430 router, copy the latest 
pp2430boot.ppc file to the PCMCIA card along with the image. This router 
does not require that the boot code be burned in to the PROM.

Note: After you enter the prom command, it must run to completion. The 
[Control]-c (abort) command is disabled for the duration of the prom 
command execution. Updating takes from 2 through 10 minutes per PROM. 
Verifying takes up to 2 minutes per PROM. 
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slot_ID is the slot location of the diagnostic PROM that you want to update.

For AN, ANH, ARN, and Passport 2430 routers, the slot_ID is always 1.

For example, enter the following command:

prom -w 2:frediag.exe 3

This command erases the diagnostic PROM image on slot 3 and copies the 
contents of the frediag.exe file on volume 2 to the PROM on slot 3.

6. Upgrade PROMs on multiple slots on your router.

If you need to update PROM images on multiple slots, use a dash to indicate a 
range of slots (2-5), or use commas or spaces to separate multiple slot 
locations (2, 3, 5 or 2 3 5).

For example, enter the following command:

prom -w 2:frediag.exe 2, 3, 5

This command erases the diagnostic PROM images on slots 2, 3, and 5 and 
copies the contents of the frediag.exe file on volume 2 to the PROMs on slots 
2, 3, and 5.

7. Verify the PROM upgrade by entering the following command:

prom -v <volume_no.>:<PROM_source_file> <slot_ID>

For example, for a boot PROM, enter:

prom -v 1:arnboot.exe 1

For a diagnostic PROM, enter:

prom -v 1:arndiag.exe 1

The system verifies that the PROM image on a designated flash volume (that 
is, the image file used as a source for upgrading the PROM) matches the 
image actually stored in the boot or diagnostic PROM on the designated slot.

The console displays one of the following messages after the verification 
terminates:

prom: slot <slot ID> completed successfully
prom: PROM data does not match file data on slot <slot ID>

If the operation succeeds, the new images stored in the boot and diagnostic 
PROMs run when you reboot the router.

If the operation fails, the console displays a message describing the cause of 
the failure.
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Task 2: Updating the Existing Configuration File

This section describes how to upgrade your existing configuration files to support 
the new Version 15.x features. Optionally, you can create a new Version 15.x 
configuration file to replace your existing configuration file for the router.

Booting the Existing Configuration File

To upgrade an existing configuration file to Version 15.x, boot it on a router 
running a Version 15.x router software image. The router software loads the 
existing configuration file into router memory and updates the configuration file’s 
version stamp to match the Version 15.x router software. It does not, however, 
automatically save that version to the file on the flash card until you save the 
configuration file in dynamic mode. After you save the file in dynamic mode, 
reboot the router, using the updated configuration file.

Saving the Configuration File in Dynamic Mode

After you boot the router with a Version 15.x image and the existing configuration 
file, save the configuration file in dynamic mode to save it directly to the router. 

To save the existing configuration file in dynamic mode:

1. In the Site Manager window, choose Tools > Configuration Manager > 
Dynamic.

The Configuration Manager window opens (Figure 17-1), displaying the
real-time router hardware and software configuration.
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Figure 17-1. Configuration Manager Window

2. Choose File > Save As.

The Save Configuration File window opens (Figure 17-2).

Figure 17-2. Save Configuration File Window

3. Enter the configuration file name config.

4. Choose the correct volume by clicking in the Volume field.
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If the volume (slot location of the memory card on the router) is not the 
volume to which you want to save this file, choose another volume. 

5. Click on Save.

The File Saved window opens (Figure 17-3), asking you to confirm your 
decision to save the file.

Figure 17-3. File Saved Window

6. Click on OK.

This action saves the configuration file (config) to the router’s flash card with 
the Version 15.x version stamp.

7. Reboot the router with the updated configuration file.
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Appendix A
Site Manager Parameters

This appendix describes the following Site Manager parameters:

You can display the same information using Site Manager online Help.

For each parameter, this appendix provides the following information:

• Parameter name

• Configuration Manager menu path

• Default setting

Topic Page

Adjacent Host Parameter A-4

ATM Port Parameters A-4

ATM Line Parameters A-7

Automated Security Association (IKE) Parameters A-11

Frame Relay PVC Parameter A-13

IP Global Parameters A-14

IP PIM Parameter A-15

NAT Global Parameter A-16

QLLC Mapping Table Configuration Parameter A-17

RADIUS Client Parameters A-18

RADIUS Access Control Parameters A-20

RIP Parameter A-21

VRRP Parameter A-22

X.25 Network Service Record Parameter A-22
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• Valid parameter options

• Parameter function

• Instructions for setting the parameter

• Management information base (MIB) object ID

You can also use the Technician Interface to modify parameters by issuing set and 
commit commands with the MIB object ID. This process is the same as 
modifying parameters using Site Manager. For information about using the 
Technician Interface to access the MIB, refer to Using Technician Interface 
Software.

Caution: The Technician Interface does not verify that the value you enter for 
a parameter is valid. Entering an invalid value can corrupt your configuration.
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OSPF/RIP Announce Policy Parameter

You use the following parameter to specify one or more BGP peers for an OSPF 
or RIP announce policy.

Parameter: From BGP Peer

Path: Configuration Manager > Protocols > IP > Policy Filters > RIP > Announce 
Policies

Path: Configuration Manager > Protocols > IP > Policy Filters > OSPF > Announce 
Policies

Default: An empty list
Options: A list of IP addresses

Function: Specifies the BGP router ID of the peer. To verify the router ID of the BGP 
peer, on the peer router, check the configured value for the Site Manager BGP 
Global parameter, BGP Identifier, or the BCC BGP parameter, router-id.

This policy applies to BGP advertisements authored by a router on this list, and 
applies only to BGP-sourced routes when BGP is included as a route source.

Instructions: Click in the From BGP Peer field and then click on the List button. Specify one 
or more IP addresses. Use the default empty list to indicate that this policy 
applies to BGP advertisements from any router.

MIB Object ID: RIP: 1.3.6.1.4.1.18.3.5.3.2.6.2.1.19
MIB Object ID: OSPF: 1.3.6.1.4.1.18.3.5.3.2.6.4.1.19
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Adjacent Host Parameter

You use the following parameter to configure the local IP address for an adjacent 
host.

ATM Port Parameters

You use the following parameters to configure the ATM T3/E3 interface on the 
Passport 5430.

Parameter: IP Local Address

Path: Configuration Manager > Protocols >IP > Adjacent Hosts
Default: 0.0.0.0
Options: Any valid IP address

Function: Specifies the IP address of the local IP interface. The adjacent host must be on 
the same subnet as the local IP interface.

Instructions: Enter the IP address in dotted-decimal notation.
MIB Object ID:. N/A

Parameter: Enable/Disable

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: Enable
Options: Enable | Disable

Function: Enables or disables this interface. 
Instructions: Set to Disable only if you want to disable the interface.

MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.2
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Parameter: Line Type

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: Autodetect
Options: For DS3, the options are DS3 M23 | DS3 CBIT Parity | Autodetect

For E3, the options are E3 Framed | E3 PLCP
Function: Sets the frame format for this interface.

Instructions: Determines the framing mode for this interface.
For DS3, if you choose DS3 M23 or DS3 CBIT Parity, be sure that the ATM line 
attribute Framing Mode is appropriately set:

If the Line Type is DS3 M23, Framing Mode should be DS3_M23 or 
T3M23PLCP.

If Line Type is DS3 CBIT Parity, Framing Mode should be DS3_CBIT or 
T3CBITPLCP.

For E3, make sure that the ATM line attribute Framing Mode is set to either 
E3_G751 or E3_G832.

MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.7

Parameter: Setup Alarm Threshold (seconds)

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: 2 
Options: 2 to 10

Function: Sets the time interval (in seconds) during which the device driver tolerates a 
performance defect or anomaly. If the performance defect or anomaly is still 
present when time interval expires, the device driver records a performance 
failure and logs an event message.

Instructions: Set the timer value in seconds.
MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.17
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Parameter: Clear Alarm Threshold (seconds)

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: 2
Options: 2 to 10

Function: Specifies the clear time (in seconds) for performance failure conditions. If the 
defect or anomaly clears within this interval, the device driver records a 
performance cleared condition and logs an event message.

Instructions: Set the timer value in seconds.
MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.18

Parameter: Loopback Configuration

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: No Loopback
Options: No Loopback | Payload Loopback | Line Loopback

Function: Forces the interface into loopback mode. The far-end or intermediate equipment 
then performs diagnostics on the network between that equipment and the T3/
E3 interface. After testing, set this parameter to No Loopback to return the 
interface to a normal operating mode.

• No Loopback — Returns the interface to non-loopback operation.
• Payload Loopback — The received signal at this interface is looped through 

the device. Typically the received signal is looped back for re-transmission 
after it has passed through the device’s framing function.

• Line Loopback — The received signal at this interface does not go through 
the framing device (minimum penetration) but is looped back out.

Instructions: Select the loopback configuration option.
MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.9
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ATM Line Parameters

You use the following parameters to configure ATM line details on the Passport 
5430. The type of ATM link module you use determines the line details that you 
can edit.

Parameter: Primary Clock

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: Loop
Options: Internal | Loop

Function: Specifies the clock signal source.
Instructions: Select Internal if you want the router to generate the clock signal source. 

Otherwise, accept the default, Loop, if you want the clock signal source to be 
external to the router.

MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.11

Parameter: Enable

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Enable
Options: Enable | Disable

Function: Enables or disables the line driver.
Instructions: Select Enable or Disable.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.2

Parameter: Interface MTU

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: 4608
Options: 0 to 9188

Function: Specifies the largest packet size (in octets) that the router can transmit on this 
interface.

Instructions: Enter a value that is appropriate for the network.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.9
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Parameter: Data Path Enable

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Enable
Options: Enable | Disable

Function: Specifies whether the router disables the interface between the driver and the 
higher-level software (the data path interface) when you disconnect the cable 
from the ATM module.

If you select Enable, then when you disconnect the cable from the ATM module, 
the router disables the data path interface after the time you specify with the 
Data Path Notify Timeout parameter.

If you select Disable, the router does not disable the data path interface when 
you disconnect the cable from the ATM module.

Instructions: Select Enable or Disable. If you select Enable, be sure to enter an appropriate 
value for the Data Path Notify Timeout parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.11

Parameter: Data Path Notify Timeout

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: 1
Options: 0 to 3600

Function: Specifies the time (in seconds) that the router waits before disabling the data 
path interface when you disconnect the cable from the ATM module, providing 
that you set the Data Path Enable parameter to Enable.

Instructions: Accept the default or enter an appropriate value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.12
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Parameter: Framing Mode

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: DS3_CBIT (for DS3 lines) | E3_G832 (for E3 lines) | T1ADM (for DS1 lines) | 

E1ADM (for E1 lines)
Options: DS3_CBIT | DS3_M32 | T3CBITTPLCP | T3M23PLCP | E3_G751 | E3_G832

Function: Specifies the transceiver mode for the physical interface.
Instructions: Select a transceiver mode as follows:

• DS3_CBIT, DS3_M32, T3CBITTPLCP, or T3M23PLCP for DS3 modules
• E3_G751 or E3_G832 for E3 modules

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.17

Parameter: Cell Scrambling

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Off
Options: On | Off

Function: If you select On, the router randomizes cell payload sufficiently to guarantee 
cell synchronization. If you select Off, cell synchronization problems can occur.

Note that ATM devices with different settings for scrambling cannot 
communicate. For example, if you configure a router to enable scrambling and 
configure a hub to disable scrambling, the router and the hub cannot 
communicate.

Instructions: If you select On, be sure to enable scrambling for all devices on the network. If 
you select Off, be sure to disable scrambling for all devices on the network.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.22
314470-15.4 Rev 00 A-9



BayRS Version 15.4.0.0 Document Change Notice
Parameter: Per-VC Clipping

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Disable
Options: Enable | Disable

Function: Enables or disables cell clipping on a per-VC basis. 
Instructions: Accept the default, Disable, for normal VC clipping. Enable this parameter if 

you want to clip cells on a per-VC basis.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.1.1.17

Parameter: DS3 Line Build Out

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Short
Options: Short | Long

Function: Conditions router signals to mitigate attenuation, which depends on the physical 
length of the line.

You can set this parameter only for DS3 modules.
Instructions: Select Short for lines shorter than 225 feet; select Long for lines 225 feet or 

longer.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.23
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Automated Security Association (IKE) Parameters

You use the following parameters to define a cryptographic key for creating IKE 
SAs between routers.

Parameter: Pre-shared Key (ascii)

Path: Configuration Manager > Protocols > IP > IKE
Configuration Manager > Edit Circuit > Protocols > Edit IP > IKE

Default: None
Options: Up to 24 ASCII characters

Function: Used as a cryptographic key for creating IKE SAs between routers. IKE is then 
used to create automated SAs for data packets.

Instructions: Enter an ASCII string, up to 24 characters. Configure the same preshared key on 
the destination router.

MIB Object ID: None

Parameter: Pre-shared Key (hex)

Path: Configuration Manager > Protocols > IP > IKE
Configuration Manager > Edit Circuit > Protocols > Edit IP > IKE

Default: None
Options: Up to 24 bytes

Function: Used as a cryptographic key for creating IKE SAs between routers. IKE is then 
used to create automated SAs for data packets.

Instructions: Enter a hexadecimal number, up to 24 bytes. (Enter the prefix 0x before the 
digits.) Configure the same preshared key on the destination router.

MIB Object ID: 1.3.6.1.4.1.18.3.5.27.1.1.9
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BGP-4-Specific Announce Policy Parameter

You use the following parameter to specify one or more BGP peers.

Parameter: Outbound Peers

Path: Configuration Manager > Protocols > IP > Policy Filters > BGP-4 > 
Announce Policies

Default: An empty list
Options: A list of IP addresses

Function: Specifies the BGP router ID of the peer. To verify the router ID of the BGP 
peer, on the peer router, check the configured value for the Site Manager 
BGP Global parameter, BGP Identifier, or the BCC BGP parameter, 
router-id.

This policy applies to BGP advertisements authored by a router on this list, 
and applies only to BGP-sourced routes when BGP is included as a route 
source.

Instructions: Specify one or more IP addresses. Configure an empty list to indicate that 
this policy applies to BGP advertisements being sent to any peer.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.6.10.1.23
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BGP-3-Specific Announce Policy Parameter

You use the following parameter to specify one or more BGP peers.

Frame Relay PVC Parameter

You use the following parameter to specify the bandwidth threshold that you want 
to set for this frame relay PVC.

Parameter: Outbound Peers

Path: Configuration Manager > Protocols > IP > Policy Filters > BGP-3 > 
Announce Policies

Default: An empty list
Options: A list of IP numbers

Function: Specifies the BGP router ID of the peer. To verify the router ID of the BGP 
peer, on the peer router, check the configured value for the Site Manager 
BGP Global parameter, BGP Identifier, or the BCC BGP parameter, 
router-id.

This policy applies to BGP advertisements authored by a router on this list, 
and applies only to BGP-sourced routes when BGP is included as a route 
source.

Instructions: Specify one or more IP addresses. Configure an empty list to indicate that 
this policy applies to BGP advertisements being sent to any peer.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.6.8.1.23

Parameter: Bw Threshold

Path: Configuration Manager > Protocols > Frame Relay > Services > PVCs
Default: 0
Options: 0 to maximum physical line speed (bits/s)

Function: Specifies the bandwidth threshold that you want to set for this PVC for traffic 
shaping purposes.

Instructions: To minimize starvation of normal- and low-priority traffic over a high-speed 
physical line (such as a 56 Kb/s lines over HSSI), set the bandwidth threshold to 
a value 3 to 10 times that set for the Throughput (CIR) parameter. Otherwise, 
accept the default, 0.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.9.2.1.58
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IP Global Parameters

You use the following parameter to disable directed broadcast.

You use the following parameter to specify the maximum number of equal-cost 
multipath support on the router.

Parameter: Directed Broadcast

Path: Configuration Manager > Protocols > IP > Global
Default: Enable
Options: Enable | Disable

Function: When this parameter is enabled, a packet addressed to an IP broadcast address 
goes to all systems on the target network. By default, directed broadcast is 
enabled. 

Caution: Internet service providers have reported forged ICMP echo request 
packets sent to IP addresses (SMURF attacks), sometimes resulting in severe 
network congestion. To prevent these attacks, directed broadcast must be 
disabled.

Instructions: Accept the default, Enable, if you want the directed broadcast feature to be 
enabled. Set to Disable if you want directed broadcast to be disabled.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.1.28

Parameter: IP OSPF Maximum Path

Path: Configuration Manager > Protocols > IP > Global
Default: 1
Options: 1 to 5

Function: Specifies the maximum number of equal cost paths allowed for a network 
installed by OSPF.

Instructions: Use the IP global Multipath Method parameter to enable multipath costs and 
specify the method that IP uses to choose the next hop for a datagram.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.1.21
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IP PIM Parameter

You use the following parameter to determine whether the router interface will act 
as a PIM bootstrap border interface.

Parameter: Bootstrap Border

Path: Configuration Manager > Protocols > IP > PIM > Interface
Default: Disable
Options: Disable | Enable

Function: When you set this parameter to Enable, this PIM interface acts as a PIM 
bootstrap border interface. A bootstrap border interface discards both incoming 
and outgoing bootstrap messages. Incoming messages originate from other PIM 
routers; outgoing messages originate from other PIM interfaces on the same 
router. When you set this parameter to Disable, this interface operates in 
accordance with RFC 2362; it accepts incoming messages and forwards 
outgoing ones.

Instructions: Set to Enable if you want the interface to discard incoming and outgoing 
bootstrap messages. Accept the default, Disable, if you want the interface to 
accept incoming messages and forward outgoing messages.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.14.2.1.32
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NAT Global Parameter

The following parameter was used when upgrading from a pre-14.20 NAT 
configuration to a 14.20 or greater version of BayRS software. This parameter 
should be set to Enable.

Parameter: Install Private Address

Path: Configuration Manager > Protocols > IP > NAT > Global
Default: Enable
Options: Enable | Disable

Function: This parameter was added in BayRS 14.20 to address a compatibility issue 
concerning non-DNS NAT translations when upgrading from a pre-14.20 NAT 
configuration to a 14.20 or greater version of BayRS software. This parameter 
should be set to Enable. Disabling this parameter can cause unpredictable 
results.

Instructions: Accept the default, Enable.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.7.1.18
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QLLC Mapping Table Configuration Parameter

You use the following parameter to enable or disable the XID Retry feature.

Parameter: XID Retry

Path: Configuration Manager > Circuits > Edit Circuits > Edit > X.25 Protocol > 
Service > QLLC

Default: Disable
Options: Enable | Disable

Function: Allows the QLLC service to retransmit the XID3 every 10 seconds to the QLLC 
endstation until it receives a response. This ensures that the endstation will 
receive the XID3 and establish a connection.

Instructions: Set this parameter to Enable to have QLLC retransmit the XID3 every 10 
seconds.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.8.1.19
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RADIUS Client Parameters

You use the following parameters to configure a RADIUS client. This section 
replaces “Client IP Address Parameter” in Appendix A of Configuring RADIUS.

Parameter: Authentication

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Create 
RADIUS > Add

or
Configuration Manager > Protocols > Global Protocols > RADIUS > Edit 
RADIUS

Default: Disable
Options: Enable | Disable

Function: Enables or disables the RADIUS client on the gateway.
Instructions: Set to Enable to activate the RADIUS client on the router. Accept the default 

value, Disable, to deactivate RADIUS authentication.
MIB Object ID: 1.3.6.1.4.1.18.3.5.22.1.1.2

Parameter: Accounting

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Create 
RADIUS > Add

or
Configuration Manager > Protocols > Global Protocols > RADIUS > Edit 
RADIUS

Default: Disable
Options: Enable | Disable

Function: Enables or disables RADIUS accounting.
Instructions: Set to Enable to activate RADIUS accounting. Accept the default value, 

Disable, to deactivate RADIUS accounting.
MIB Object ID: 1.3.6.1.4.1.18.3.5.22.1.1.3
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Parameter: Client IP Address

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Create 
RADIUS > Add
or
Configuration Manager > Protocols > Global Protocols > RADIUS > Edit 
RADIUS > Edit

Default: None
Options: A 32-bit IP address

Function: Identifies the RADIUS client. This address applies to the entire router.
Instructions: Enter the IP address of the router. If the RADIUS server is already configured, 

Site Manager automatically supplies the address.
MIB Object ID: 1.3.6.1.4.1.18.3.5.22.1.1.5

Parameter: Debug Message Level

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Create 
RADIUS > Add
or
Configuration Manager > Protocols > Global Protocols > RADIUS > Edit 
RADIUS

Default: NODEBUG
Options: ONE | TWO | THREE | NODEBUG

Function: Assigns the level of RADIUS debug messages that the RADIUS client logs.
Instructions: Accept the default value, NODEBUG, unless you are specifically trying to 

debug the connection.
MIB Object ID: 1.3.6.1.4.1.18.3.5.22.1.1.7
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RADIUS Access Control Parameters

You use the following parameters to modify router access.

Parameter: User Manager Lock

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Access 
Control

Default: Disabled
Options: Enable | Disable

Function: Allows you to modify access to the router by enabling or disabling the user/
manager lock.

Instructions: Set to Enable to lock out the user and manager profile and allow access only by 
individual users with a unique profile. Accept the default value, Disable, to 
allow access by all users with the manager or user profile, in addition to users 
with a unique profile.

Note: If the user/manager lock is enabled and the RADIUS server becomes 
unavailable, the message “RADIUS wait state” appears in the User Manager 
Lock field. When the RADIUS server becomes available, the value reverts to 
Enable.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.22.1.10

Parameter: Login Accounting

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Access 
Control

Default: Disable
Options: Enable | Disable

Function: Enables or disables login accounting.
Instructions: Set to Enable if you want RADIUS Accounting messages to be sent to the 

RADIUS server. Accept the default value, Disable, to prevent RADIUS 
accounting messages from being sent to the server.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.22.1.11
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RIP Parameter

You use the following parameter to specify whether the router imports RIP-1 
updates only, RIP-2 updates only, or both RIP-1 and RIP-2 updates from a 
neighbor router.

Parameter: RIP Compatible

Path: Configuration Manager > Protocols > IP > RIP Interfaces
Default: Disabled
Options: Enable | Disable

Function: Specifies whether RIP-1 accepts both RIP-1 broadcast and RIP-2 multicast 
packets (and have RIP-2 always use multicast for transmitting updates), or 
whether RIP-1 accepts RIP-1 broadcast and RIP-2 broadcast packets only 
(RIP-1 will not accept RIP-2 multicast packets) and have RIP-2 broadcast the 
packets, making it compatible with RIP-1.

Instructions: Accept the default, Disable, if you want RIP-1 to accept both RIP-1 broadcast 
and RIP-2 multicast packets. Select Enable if you want RIP-1 to accept RIP-1 
broadcast and RIP-2 broadcast packets only.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.2.2.1.22
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VRRP Parameter

You use the following parameter to enable or disable the VRRP ping feature.

X.25 Network Service Record Parameter

You use the following parameter to enable or disable the No Calling Address 
feature.

Parameter: VRRP Address Ping

Path: Configuration Manager > Protocols > Global Protocols > IP > VRRP
Default: Disable
Options: Enable | Disable

Function: Allows you to ping a master virtual router that is not the owner of the virtual 
router IP address. This feature is useful for checking network connectivity.

Instructions: Set to Enable to allow the router to ping a master virtual router that is not the 
owner of the virtual router IP address. Accept the default, Disable, to prevent 
that master virtual router from responding to a ping. When this feature is 
disabled, VRRP is in full compliance with RFC 2338.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.25.1.1.15

Parameter: No Calling Address

Path: Configuration Manager > Circuits > Edit Circuits > Choose an Interface >
Edit > X25 Protocol > Service

Default: Off
Options: On | Off

Function: Allows the router to accept incoming X.25 calls for QLLC service from devices 
that do not have an X.121 calling address. Only one X.25 connection can be 
supported at any given time.

Instructions: Set this parameter to On to allow the router to accept incoming X.25 calls for 
QLLC service from devices that do not have an X.121 calling address.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.2.1.55
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